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This training guide can be used to supplement self-training in SedonaOffice. It covers basic functions in SedonaOffice and is not intended for use as an in-depth software manual.
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[bookmark: _Toc469993021]SedonaOffice Orientation
[bookmark: _Toc317512499][bookmark: _Toc469993022]Access SedonaOffice
1. Open Internet Explorer and navigate to yourcompany.sedonaoffice.com*
2. Enter your windows login credentials
a. e.g. username: SedonaASP\YourCompany1, password: 12345
3. Click connect on any dialogue box that opens
4. Once you are logged in, select the SedonaOffice Client application
5. You may be required to enter your windows login twice. If so, re-enter your credentials to logon to the virtual machine
6. In the SedonaOffice login window, enter your SedonaOffice username and password
a. e.g. username: RandyW, password: pass99
7. Click Login or press Enter
8. Select your database (Live or Sandbox)
9. Congratulations! You have logged onto SedonaOffice.
*replace “yourcompany.sedonaoffice.com” with the appropriate URL provided in your Login Credentials email


[bookmark: _Toc317512500][bookmark: _Toc469993023]Navigate the SedonaOffice Interface
[bookmark: _Toc317512501][bookmark: _Toc469993024]Area 1: The Toolbar
The toolbar allows you to perform actions such as opening and closing your companies, printing, and customer lookup.
[bookmark: _Toc317512502][bookmark: _Toc469993025]Close a company
a. Click File
b. Click Close Company
c. Select the database you would like to close
d. Click OK
[bookmark: _Toc317512503][bookmark: _Toc469993026]Open a company
a. Click File
b. Click Open Company
c. Select the database you would like to open from the drop-down list
d. Click Select
[bookmark: _Toc317512504][bookmark: _Toc469993027]Find a customer
a. Option 1: The Client Management module
1) Open the Client Management Module
2) Click Customer Explorer
3) Select the criteria on which you would like to search
4) Enter text in the search field
5) Click the green arrow
6) Highlight and double-click the appropriate customer, or highlight and click Select
b. Option 2: The drop-down list
1) Enter a customer name or number in the drop-down list in the toolbar
2) Hit enter on your keyboard or click the binoculars icon
3) You may also open the drop-down list and select from recently accessed accounts
c. Option 3: The binoculars icon
1) Click on the binoculars icon next to the drop-down list
2) Select the criteria on which you would like to search
3) Enter text in the search field
4) Click the green arrow
5) Highlight and double-click the appropriate customer, or highlight and click Select
[bookmark: _Toc317512505][bookmark: _Toc469993028]Print a document
a. Open a document or a record, such as an invoice
b. Click on the print preview icon in the toolbar or File > Print Preview
c. You may choose to save the document to the server in one of several formats, including PDF or Excel
d. Click Print & Close or File > Print
[bookmark: _Toc317512506][bookmark: _Toc469993029]Delete a record
a. Open an item such as an invoice or purchase order
1) Note that the record must not have any transactions, open or closed, against it or you will be unable to delete it
b. Click on the red delete icon in the toolbar
c. When asked if you want to delete the record, click yes
[bookmark: _Toc317512507][bookmark: _Toc469993030]Area 2: The Company Explorer
The company explorer is comprised of the various modules in SedonaOffice. Each module has several functions associated with it. An individual user’s view of the modules in this area will differ depending on the permissions given to that user.
[bookmark: _Toc317512508][bookmark: _Toc469993031]Client Management
This module allows you to perform cancellations, collections, company rate changes, customer lookup, and customer queries. You can also manage EFT customers, chain accounts and master accounts, and create new customers.
[bookmark: _Toc317512509][bookmark: _Toc469993032]Accounts Receivable
This module allows you to perform cycle invoicing, process finance charges, make deposits, process payments, print invoices, and create statements. You can create invoices and credit memos directly through this module as well as view a list of customers with unapplied cash or credit.
[bookmark: _Toc317512510][bookmark: _Toc469993033]General Ledger
In this module, you are able to maintain your chart of accounts, manage accounting periods, create and view journal entries, view your account register, reconcile bank accounts, and manage royalties and commissions. You can work with the GL query builder from this module.
[bookmark: _Toc317512511][bookmark: _Toc469993034]Accounts Payable
The Accounts Payable module is where you access vendors and vendor bill information, as well as create and pay bills. You may also write and print checks here, create and receive purchase orders, manage AP recurring items, and view your suggested purchase order list. You can work with the AP query builder from this module.
[bookmark: _Toc317512512][bookmark: _Toc469993035]Inventory
In this module, you can issue parts, process returns, manage manufacturers and warehouses, complete transfers between warehouses, add parts to SedonaOffice, and create repair orders. This is also the module in which you will manage physical inventory counts and adjustments. You can also work with the part query builder from this module.
[bookmark: _Toc317512513][bookmark: _Toc469993036]Job Management
This module allows you to track and invoice all jobs (open or closed), view and schedule appointments, and manage timesheets. This module is an integral part of job processing. You can work with the job query builder from this module. This module will integrate with the QuoteWerks or Wesuite add-on softwares.
[bookmark: _Toc317512514][bookmark: _Toc469993037]Payroll
The Payroll module will help you keep track of employee timesheets. This module is used in conjunction with your current payroll software/company.
[bookmark: _Toc317512515][bookmark: _Toc469993038]Sales Management
The Sales Management module is a useful tool for organizing and managing your opportunities (potential jobs) and prospects (potential customers). This module also allows you to convert a prospect into a customer. This module will integrate with the QuoteWerks add-on software. 
[bookmark: _Toc317512516][bookmark: _Toc469993039]Service
In this module, you will manage all tasks related to service calls, including ticket creation, scheduling, and invoicing. You will also manage all inspections through the Service module. This module will integrate with the FSUWeb or SageQuest add-on softwares.
[bookmark: _Toc317512517][bookmark: _Toc469993040]General Documents
General Documents is a storage area used to keep documents not related to a specific record (e.g., jobs/service, customer, vendor). It is only available with SedonaDocs.
[bookmark: _Toc317512518][bookmark: _Toc469993041]Lock Table Maintenance
Lock Table Maintenance allows you to unlock any records that are being accessed by another user. The record has to have been open for a minimum of ten minutes. Access to this tool can be restricted through user permissions.
[bookmark: _Toc317512519][bookmark: _Toc469993042]Management Summary
The Management Summary contains a library of reports that display in a graphical format.
[bookmark: _Toc317512520][bookmark: _Toc469993043]Report Manager
The Report Manager contains a library of reports created by SedonaOffice for your use. You will find many reports from each module, including RMR tracking reports, a basic balance sheet, and job/service reports.
[bookmark: _Toc317512521][bookmark: _Toc469993044]Sedona Setup
This tool contains the setup tables, processing options, and company information that SedonaOffice needs to run according to your specific needs. Most of this information is filled in prior to your go live date.
[bookmark: _Toc317512522][bookmark: _Toc469993045]Area 3: The Dashboard
The dashboard is where all open records will be displayed. You can have multiple windows open, and you can maximize and minimize windows.
[bookmark: _Toc317512523][bookmark: _Toc469993046]Explorer Layout
Most items, such as customers, vendors, and parts, will open in a window called an explorer. Each explorer has a similar file tree layout.
[bookmark: _Toc317512524][bookmark: _Toc469993047]Example: The Customer Explorer
	The customer explorer is comprised of four areas:Area 1: File Tree
Area 2: Billing
Area 3: Basic Customer Information
Area 4: Dashboard Display
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[bookmark: _Toc317512525][bookmark: _Toc469993048]
Sales Management & New Accounts
Follow this link to watch instructional videos on the Sales Management and Client Management modules:
Sales Management & New Accounts Playlist
[bookmark: _Toc469993049][bookmark: _Toc324754396]Sales Management 
[bookmark: _Toc469993050]Manage Prospects and Opportunities
[bookmark: _Toc324754397][bookmark: _Toc469993051]Area 1: The Prospects List
The prospects list allows you to keep track of potential customers. You can order the list by clicking on the column headers. You can also filter the view by selecting options from the dropdowns. A prospect in this list will turn red when the follow-up date has passed. 
[bookmark: _Toc324754398][bookmark: _Toc469993052]Reorder the prospect list
a. Go to the Sales Management  module
b. Select Prospects
c. Click once on the header by which you wish to sort (e.g. Follow-up Date)
d. The list will now be sorted based on the column you selected
[bookmark: _Toc324754399][bookmark: _Toc469993053]Filter the prospect list
a. Select an option from one of the drop-downs at the top of the prospect list (e.g. Salesperson)
b. The list will now only show prospects within the option selected
[bookmark: _Toc324754400][bookmark: _Toc469993054]Open a prospect
a. Highlight the prospect you want to open and:
1) Double-click, or
2) Select Open on the bottom right
[bookmark: _Toc324754401][bookmark: _Toc469993055]View inactive prospects
a. Select the “Show Inactive” checkbox on the bottom left of the Prospects module
b. The list will now include prospects that have been made inactive
[bookmark: _Toc324754402][bookmark: _Toc469993056]Area 2: The Opportunities List
The opportunities list allows you to keep track of current job opportunities. Each prospect can have multiple opportunities. You can order the list by clicking on the column headers. You can also filter the view by selecting an option such as opportunity type.
[bookmark: _Toc324754403][bookmark: _Toc469993057]Reorder the opportunities list
a. Go to the Sales Management  module
b. Select Opportunities
c. Click once on the header you wish to sort by (e.g. Follow-up Date)
d. The list will now be sorted based on the column you selected
[bookmark: _Toc324754404][bookmark: _Toc469993058]Filter the opportunities list
a. Select an option from one of the drop-downs at the top of the prospect list (e.g. Opportunity Type)
b. The list will now only show opportunities with the option selected
[bookmark: _Toc324754405][bookmark: _Toc469993059]Open an opportunity
a. Highlight the opportunity you want to open and:
1) Double-click, or
2) Select Open on the bottom right
[bookmark: _Toc324754406][bookmark: _Toc469993060]View inactive opportunities
a. Select the “View Inactive” checkbox on the bottom left
b. The list will now include opportunities that have been made inactive
Note: If there are multiple opportunities on a prospect, you can inactivate one opportunity without inactivating all opportunities or the prospect.
[bookmark: _Toc324754395][bookmark: _Toc469993061]Enter Prospects
1. Select Prospects in the Sales Management module
2. Click New on the bottom right to open the New Prospect form
3. Enter basic prospect information
a. Required fields
i. Residential or Commercial
ii. Name
iii. Source
iv. Status
v. Temperature
vi. Sales Department
vii. Salesperson
4. Enter the next follow-up date to turn the prospect red when the date passes, if desired. 
5. Do not enter a resolution or resolution date until the prospect has signed or declined the contract.
6. Click Apply
Note: The buttons in the lower left section of the screen for Email, vCalendar, Create vCard, and Import require you to set up MS Outlook on the SedonaOffice server. The Mail Merge button requires setup of letter templates on the server. Please email support@astutefinancial.biz for information on how to set up these areas. 
7. Enter custom detail information in the Qualifications screen (this can be customized in SedonaSetup > User Defined Setup)
8. Enter contact information in the Contacts screen
a. Click New
b. Enter contact name and address
i. All other fields are optional
c. Click Save
d. Repeat for all contacts
Note: Contacts do not transfer when a prospect is converted to a customer
9. Enter jobs/systems for the prospect in the Opportunities screen
a. Enter an opportunity title (e.g. “Res-Burg for John Doe” or “CCTV for John Doe”)
i. This title will appear in the Opportunities screen, so give it a name you will easily recognize for the prospective customer. Opportunities usually reflect each install or system type the customer will be purchasing. If you do not wish to track multiple opportunities, enter a generic title here. 
b. Select residential or commercial
c. Enter the site name (the physical location where the system will be installed)
d. Enter the site address
e. Enter opportunity information
i. Required fields
1. System Type
2. Status
3. Quote Type
4. % to Close
f. Enter sales items quoted for this opportunity (optional)
i. You can include all recurring items and installation charges in this area to track quoted prices. Click under Sales Item and use the dropdown that appears to choose from your items. These items are set up in Sedona Setup > Sales Items. 
Example:
[image: ]
g. Click Save
Note: when leaving the opportunities screen, you will be prompted to save before exiting. Do not choose to save the new record (SedonaOffice automatically opens a new opportunity after saving the one you just created).
10. View or enter notes for this prospect in the Note Log screen
a. Automatic notes will be logged by the program for all actions taken on this prospect
b. You can also enter manual notes in this area
[bookmark: _Toc324754407][bookmark: _Toc469993062]Resolving an Opportunity
Upon winning or losing a prospect, you will have to first resolve the opportunity. If accepted, you can then turn the prospect into a new account in SedonaOffice. If declined, you will inactivate the opportunity and/or the prospect. If the prospect has more than one opportunity, make sure to close each opportunity without choosing ‘Create Customer’ or ‘Inactive Prospect’ until you reach the last opportunity.
[bookmark: _Toc324754408][bookmark: _Toc469993063]Resolving an accepted (i.e. sold) opportunity
a. Open the prospect either through the prospects or the opportunities list
b. Change the status of the prospect to “Sold” from within the Prospect button
c. Choose a Resolution (i.e. accepted or declined)
d. Choose a resolution date
e. Go to the Opportunities button
f. Double-click on the opportunity
[image: ]
g. The opportunity information will be displayed
h. Click Resolve at the bottom left
i. Choose “Accepted” in the drop-down list
j. Enter a resolution date
k. Select the main competitor for this opportunity, if applicable
l. Select “Close Opportunity”
m. Select “Inactivate Prospect” (if this is the only opportunity for this prospect)
n. Select “Create Customer” (if this is the only opportunity for this prospect)
o. Do not select “Create Job” at this time. You will begin a new job after the customer has been fully created. 
p. Click Save
1) If the customer has more than one open opportunity, follow steps F – L and save without inactivating the prospect.
2) Inactivate all opportunities until you reach the last opportunity. At this point, you can choose “Inactivate Prospect” and “Create Customer.”
Note: If you selected, Create New Customer, the New Customer Setup screen will be displayed at this time. You can find instructions for completing a new account here.
[bookmark: _Toc324754409][bookmark: _Toc469993064]Resolving a declined (i.e. lost) opportunity
a. Open the prospect either through the prospects or the opportunities list
b. Change the status of the prospect (e.g. “Lost”) from within the Prospect button 
c. Enter a resolution date
d. Go to the Opportunities screen
e. Double-click on the opportunity
[image: ]
f. The opportunity information will be displayed
g. Click Resolve on the bottom left
h. Enter a resolution date
i. Choose “Declined” in the drop-down list
j. Select the main competitor for this opportunity, if applicable
k. Select “Close Opportunity”
l. Select “Inactivate Prospect” (if there are no other open opportunities for this prospect)
m. Do not select “Create Job” or “Create Customer”
n. Click Save
1) If the customer has more than one open opportunity, follow steps D – K and save without inactivating the prospect.
2) Inactivate all opportunities until you reach the last prospect. At this point, you can choose “Inactivate Prospect.”
[bookmark: _Toc324754410][bookmark: _Toc469993065]New Accounts
[bookmark: _Create_a_New][bookmark: _Toc324754411][bookmark: _Toc469993066]Create a New Account
a. The New Customer Setup form will automatically open if you are converting a prospect into a customer from Sales Management. You also have the option to select New Customer in the Client Management module to start a new customer account. If you are creating a customer from a prospect record, this form will open automatically once you select “Create Customer.” 
b. Select “Show Explorer” and “Create New System” in the upper right corner of the form
a. These checkboxes will give you access to the system tab in this form, and it will open the customer page upon completion of the form
c. The first tab, Customer Information, will open
a. Enter the customer name and the bill to information, including the bill to name and address and whether it is a residential or commercial billing address.
b. Enter all basic customer information
i. Required fields
1. Name
2. Billing Address
3. Customer Type
4. Default Terms
5. Salesperson
6. Branch
ii. Optional fields: 
1. Old Customer ID: usually filled out for reference after conversion from another software
2. Tax Exempt #: this field is informational only; you MUST enter the tax exempt number on the site in order to prevent invoices from charging tax
3. Bypass RMR Increases Until: this field is informational only; you MUST enter this date on the system or recurring item in order to prevent this customer from receiving RMR increases until the entered date
4. Blanket PO: the PO number entered here will show on every invoice created on this account
5. Expiration Date: expiration date for the blanket PO number
6. Chain Account: groups customers together who have something in common, such as routing area, which can then be viewed in Client Management/Chain Accounts
7. Customer Groups: groups customers together so that user access can be restricted to specific groups. Usually used in conjunction with multiple branches.
c. Select the invoice printing options for the customer
i. The checkboxes at the bottom of the form under Invoice Printing will determine:
1. if the customer should receive a printed cycle invoice
2. if they should be excluded from collections
3. if each site on the account should receive a separate cycle invoice
4. if this customer should be charged late fees
5. if they will be included in statement printing 
d. Go to the second tab (Site Setup)
a. Enter the number, name and address for the first site if it is different than the billing information (more sites can be created later)
b. Determine if the site is residential or commercial
c. Enter other basic site information
i. Required fields
1. Customer Since date
2. Tax Group service and miscellaneous invoices
3. Cycle Tax Group for cycle invoices
e. Go to the third tab (System)
a. Enter a system account number
Note: for monitored accounts, this is the central station number; for other accounts, enter a unique number, such as the customer number and the system type (e.g. 10427-CCTV)
b. Enter other basic system information
i. Required fields
1. System Type
2. Panel Type
3. Warranty: allows service tickets to bill according to warranty rules
4. Service Level: allows service tickets to bill according to service level rules
5. Primary Service Company
ii. Optional fields:
1. Panel location 
2. Monitored By
3. Memo: appears on service tickets
4. Alternate Service Company 1&2: companies that will perform service in the event that your company will not be servicing a future ticket
5. Comments: appears on service tickets
6. Contract info: if a cancellation is performed through the Cancellations module, the balance of contract will be calculated from this information
7. OK to Rate Increase After: prevents RMR items from receiving increases until the date entered
8. Cycle Purchase Order Info: PO number entered here will appear on cycles invoices only until expiration date entered
f. Go to the fourth tab (RMR)
Note: the RMR tab is usually skipped because RMR for new accounts is typically set up in the job to provide accurate job costing. Only complete this tab is you are not planning on entering a job into SedonaOffice for this customer.
a. Click New
i. Recurring Item: loads all recurring type items from Sedona Setup>Invoice Items
ii. Description: automatically loads from item, but can be changed per RMR item
iii. Sub Item Of: allows you to group RMR items together so that SedonaOffice users can view the detail, but the customer cannot. All RMR items on a site with the same Sub Item Of will be grouped together on cycle invoices.
iv. Bill Cycle: frequency at which you will bill this recurring item (i.e. monthly, annually, etc.)
v. Next Cycle Date: month you will begin to bill the recurring item
vi. Memo: appears on cycle invoices
vii. Reason for Add: used in RMR reporting
viii. RMR Start Date: date you will begin to bill the recurring item. If this date is set prior to the next cycle date, it will be used for reporting purposes only; the RMR will begin billing on the next cycle date. If the start date is set after the next cycle date, the RMR item will be prorated for the first month; the RMR will begin on the start date.
ix. Comments: internal only
b. Click Add and repeat for each item. 
g. Go to the fifth tab (Custom Fields)
a. Fill out any custom fields that your company has created. These can be set up in Sedona Setup/Custom Fields Setup (Customer) in the CM area. 
h. Click Save
a. The new customer’s account will open. 
[bookmark: _Toc324754412][bookmark: _Toc329089690][bookmark: _Toc469993067][bookmark: _Toc324754414][bookmark: _Toc329089691]Client Management

[bookmark: _Toc393805370][bookmark: _Toc396826930][bookmark: _Toc469993068]Follow this link to watch instructional videos on the Client Management module:
Client Management Playlist
[bookmark: _Toc469993070]Add and Edit Billing, Site and System Information
Customer accounts can have as many sites and systems as needed, with as many billing or site contacts as necessary within each record. Billing information is held at the customer level, and multiple billing addresses can be set up. Invoices and recurring items can point to whichever billing address is appropriate. 
[bookmark: _Toc329089692][bookmark: _Toc469993071][image: ]Add Billing Information
1. Open the customer page
2. Right click on the Bill To folder
3. Select New Billing Information
4. Enter the billing information
a. Required fields
i. Residential or Commercial
ii. Name
iii. Address	
iv. Phone number
b. Indicate if this is the primary billing address
i. Checking primary will remove this setting from the current primary billing address. 
c. Check Primary RMR/Service/Job/Other to indicate the types of invoices that should be sent to this billing address
d. Check “Email Invoices” only if you are using the software add-on PDFxPlode or SedonaSync
e. Save 
[bookmark: _Toc469993072]Edit Billing Info
1. Right click on the bill name/address under Bill To
2. Select Edit Billing Information
3. Add or delete desired information 
4. Check Inactive to inactivate the address without permanently removing it from the account
5. Click the “delete data” button at the top left in the toolbar to permanently remove the bill to. 
6. You must have another primary bill to in place before you can take this step. 

[image: ]

7. Save 
[bookmark: _Toc329089693][bookmark: _Toc469993073]Add/Edit Contacts
[bookmark: _Toc469993074]Add a Billing Contact
[bookmark: _Toc469993075]Option one
1. [image: ]Open the customer’s page
2. Under Bill To, expand the billing folder
3. Right click on Contacts
4. Select New Bill Contact
5. Enter the contact information
a. Required fields
i. Name
ii. Phone number
b. Check Collection Contact to make this name appear in the collections module
c. Check Cycle Invoice Contact to include this name on future cycle bills
d. Make at least one selection in the Bills and Sites tab 
i. This person can be made as a contact for as many sites or bill addresses as necessary. This will allow the user to select this contact on invoices, service tickets, etc.
6. Save
[bookmark: _Toc469993076]Option two
1. Expand the Bill To name/address in the customer explorer
2. [image: ]Right click on the bill to
3. Select Edit Billing Information
4. Go to the Contacts tab
5. Select New
6. Complete the new contact form

7. Click on the Bills and Sites tab and make a selection
8. Save
[bookmark: _Toc469993077]Edit a Contact
1. Under Bill To, expand the name/address
2. Click on Contacts
3. In the dashboard display, right click on a contact’s name and select edit or double click on the name
4. Add or delete the appropriate information and select Save
[bookmark: _Toc329089696][bookmark: _Toc469993078]Add/Edit System Information
Add a new system
1. Open the customer’s page 
2. Expand the Sites folder, and then the site to which you are adding a system.
3. Right click on Systems and select New System
[image: ]
4. Fill out appropriate information for the new system
a. Enter the central station number into the system number field. 
i. This should be a unique number; system account numbers cannot be duplicated in a SedonaOffice database unless specified in Sedona Setup/Setup Processing (AR). If this is a non-monitored account, develop a unique numbering system for these situations, such as customer number-system (i.e. 10589-CCTV).
b. Save
[bookmark: _Toc469993079]Edit a system
1. Click on Systems under the correct site
2. Right click on the system in the display dashboard
3. Select Edit System
a. The remaining tabs have now become available for you to input information
i. Do not add recurring or equipment here, as that is usually added through a job
b. Change and edit the information on this page when necessary
4. [bookmark: _Toc329089695]Save 
[bookmark: _Toc469993080]Add a new site to an existing customer
1. Right click on the Sites folder and click on New Site
2. Complete the site tab. 
a. For instructions on adding a new site, click here. 
3. Save
[bookmark: _Toc469993081]Edit Site Information
1. Open the customer page
1. Right click on the appropriate site
1. Select Edit Site
1. Edit the site information
Note: Make sure that tax groups match the site address
1. Save
[bookmark: _Toc324754415][bookmark: _Toc329089697][bookmark: _Toc469993082]Create Recurring Items
1. Open the customer page
2. Right click on Recurring near the bottom of the file tree
3. Select New Recurring and choose the system
4. Complete the recurring page
Note: the bill on day option can be turned on from Sedona Setup/Setup Processing (AR)
a. Required fields
i. Recurring Item
ii. Description
iii. Bill Cycle
iv. RMR Amount
v. Next Cycle Date
vi. Reason for Add
b. Optional fields:
i. Renewal date: can be used in Company Rate Change function as criteria for company-wide rate increase/decrease
ii. Rate increase date: prevents this item from being increased until this date
iii. Override percentage
iv. PO number: will appear on invoices created from this RMR item
v. PO expires: expiration date for this PO number
vi. Reference: internal only
vii. Memo: appears on the invoice
c. Enter the item, billing frequency and monthly amount. 
Note: Deselect “Enter as Monthly Amount Only” to enter the cycle amount
d. Sub Item Of:	
i. Allows you to group RMR items together so that SedonaOffice users can view the detail, but the customer cannot. All RMR items on a site with the same Sub Item Of will be grouped together on cycle invoices.
e. Bill as of the first of the month:
i. In the Next Cycle Date field, choose the month that you will begin to bill the customer, i.e. if the install date is February 6rd, you will typically bill them for the month of February. You may want to prorate for the days in February during which the customer was not monitored, which is done through the cycle start date. Choose a next cycle date of 01-Feb-2013 and a cycle start date of 2/6/13. This will bill the customer for twenty-two days in February and then bill for the entire month starting in March. If you wish to bill the customer for the entire month, simply choose a cycle start date of the first of the month. If this date is set prior to the next cycle date, it will be used for reporting purposes only; the RMR will begin billing on the next cycle date, i.e. 01-Feb-2013. 
f. Bill as of service start (Bill on Day):
i. Choose the day of the month that the service will start in the Bill on Day dropdown. Match the recurring start date to the bill on day. The customer will be cycled according to this bill on day for this recurring item from now on. 

[image: ]

g. Invoice Group #:
i. Recurring items can be cycled separately according to bill on day, branch or master account status. If you would like to separate cycle billing further, enter a number into the Invoice Group # field to create cycle groups. For example, if you would like to bill monthly, quarterly and annual customers separately, you will enter a number into each recurring item according to the frequency. Enter a 1 into Invoice Group # for monthly customers, a 2 for quarterly customers and a 3 for annual customers. Leave this field blank (0) if all cycles will be billed at the same time.
h. Save
Note: Recurring can also be adding by right clicking on Recurring under the specific system. Open the folder for the site, then the system that is gaining a recurring item and right click on the Recurring folder under that system.
[bookmark: _Toc324754416][bookmark: _Toc329089698][bookmark: _Toc469993083]Process Cancellations
[bookmark: _Toc469993084]Initial Cancellation
1. Open Cancellations under Client Management in the Company File Tree
2. Select New at the bottom right side of the screen
3. From the customer look up screen, search for and choose the customer being cancelled
4. Complete the cancellation form
a. Choose the reason for cancel in the RMR Reason dropdown
b. Choose a Cancel Profile according to the type of cancellation (each cancel profile has a unique task list)
c. Optional: Enter pertinent information in the Reference field, i.e. amount owed on account, employee responsible for completion of cancellation, etc.
d. Notice Date: date the customer notified the company of the cancellation
e. Effective Date: the last day the RMR will be billed in SedonaOffice. This date will be entered as the end date on RMR items
f. Follow Up Date: date you wish to check back on the cancellation’s progress. The customer name in the cancellations module will turn red when this date has passed to help you track the work that needs to be done for each cancellation.
g. CS Cancel Date: the last day that your central station will monitor this account. This date only appears when CS Cancelled is checked.
i. Full Cancellation:
1. This button will cancel all sites and systems
ii. Partial Cancellation:
1. Do not select the Full Cancellation button
2. From the Sites tab, choose which site is being cancelled
5. Save
[bookmark: _Toc469993085]Following up on a cancellation
1. Double click on a cancelled customer in the queue
2. Enter a new follow-up date, if necessary
3. Click on the Tasks tab
a. Check each task as you complete it
4. When all tasks are flagged, a Completed checkbox will appear at the bottom left side of the screen
5. Check Completed when you are ready to finish the cancellation, remove the customer from the cancellations queue and give the customer a ‘CANC’ status in SedonaOffice
6. Select Save 
7. Check the Completed Only checkbox in the Cancellations queue to show and edit the cancelled customer
[bookmark: _Toc324754417][bookmark: _Toc329089699][bookmark: _Toc469993086]Manage Collections
The collections module consists of “queues” of overdue customers, separated between automatic and manual queues. Automatic queues indicate a number of days overdue (i.e. 30-59 Days Past Due) and will be automatically populated when the queue is refreshed. Manual queues do not automatically populate and are created to group similar customers together (i.e. Do Not Call or Sent to Collections). Customers must be manually moved from an automatic queue to a manual queue. 
1. Expand the Client Management module, then click on Collections 
2. Before working in your Collections profile list, make sure that your list is refreshed. To run the Auto Process Refresh, click on the refresh button, shown below: 
[image: ]
3. Select Yes when you are prompted to run the refresh for all profiles
4. You must also age your database regularly in order to use the Collections module. Click here for directions on aging. 
5. Double click on a line to open the queue of customers 
6. Double clicking on a customer name will open the customer explorer record
7. The top of the queue has seven buttons that edit the queue
a. [image: ]  Add Customer to Queue 
i. After clicking this button, choose a customer in the explorer and double click.
ii. Enter the follow up date, status and any pertinent notes.
iii. Save
b. [image: ]  Add Collections Notes 
i. Highlight a customer’s name (click on the name once) and click on the notes icon.
ii. Type your note in the text box and click Add Notes 
1. These notes should be used to document the outcome when contact is made with the customer.
iii. All saved notes will show up in the gray text box under Current Collections Notes.
c. [image: ]  Add Manual Event 
i. Click this icon when you need to document action taken on a customer’s account related to collections work, such as calling for payment, leaving a message or sending a letter. 
ii. Enter a follow up date, status, collection activity, and pertinent notes.
iii. Save
d. [image: ]  Move to Another Collection Queue
i. Highlight the appropriate customer and click the Move to Another Collection Queue icon when you would like to move a customer from an automatic queue to a manual queue or from one manual queue to another. Customers should not be moved manually from one automatic queue to another automatic queue. 
ii. Double click on the queue you want the customer to be moved into.
iii. Sedona will prompt you to move the customer. 
iv. Select Yes and the customer will disappear from the list.
e. [image: ]  View Event History 
i. This icon lists all activity and actions taken on customers within this queue. Notes will appear within this list so you can track the progress of each collections queue.
f. [image: ]  Mail Merge 
i. Click this icon to generate collections letters for the highlighted customers (email support@astutefinancial.biz for instructions on setting up Mail Merge)
g. [image: ]  Select All in Queue 
i. This icon highlights all customers in this list so you can use mail merge to contact all of those customers
[bookmark: _Toc469993087]Removing Customers from Collections Queues
To entirely remove a customer from collections, they must first be moved from a sequenced queue to a non-sequenced queue. You can then remove them from collections. Make sure to mark the customers as a “No Collections” customer or they will be pulled into collections the next time the queues are refreshed.
[bookmark: _Toc469993088]Removing from a sequenced queue
1. Highlight the customer record in collections
2. [image: ] Click on the Move to Another Collections Queue
3. Double click on the non-sequenced collection queue the customer should be moved to
4. The customer has now been moved into a non-sequenced queue and will stay in this queue indefinitely unless they are removed. 
[bookmark: _Toc469993089]Removing from a non-sequenced queue
1. Go into the non-sequenced collections queue and highlight the customer
2. Right click and select Remove Customer from Collections
[bookmark: _Toc469993090]Mark Customers as a “No Collections” Customer
1. Open the customer account
2. Right click on Customer Information and click on Edit Customer Setup
[image: ]
3. Check “No Collections” and Save
[image: ]

[bookmark: _Toc329089700][bookmark: _Toc469993091]Accounts Receivable
[bookmark: _Toc329089701]Follow this link to watch instructional videos on the Accounts Receivable module:
Accounts Receivable Playlist
[bookmark: _Toc469993092]Process Cycle Invoices
Before processing cycles, customers must be set up with active RMR items. The customer’s RMR will only run if the Next Cycle Date on the recurring item matches the cycle date chosen in Cycle Invoicing. 
[bookmark: _Toc329089702][bookmark: _Toc469993093]Create a New Cycle Invoicing Batch
1. Open Cycle Invoicing under the Accounts Receivable module
2. Select New
3. Choose the month for which you are billing
4. In the ‘Include Customers with Bill Day’ dropdown, allow the default to stay at 28
a. You can cycle customers according to Bill On day or on the first of the month. This setting is chosen in AR Setup Processing in Sedona Setup. If your bill cycle is not the first of the month, you may use this selection to determine which customers with certain billing days will be cycled. For example, choose a bill day of 15 to run cycle billing for customers with a bill day between the first and the 15th of the month.
5. Select the branch or check All Branches
6. Save
7. SedonaOffice will ask if you are ready to begin; select Yes
a. The cycle is now available in Cycle Invoicing. To view the customers in this cycle, right click on the cycle batch and select Print > Cycle Detail. If this report shows customers with incorrect dates or charges, you must correct the customers’ recurring items, then delete the cycle and recreate it. Right click on the cycle and select delete to remove it. 
8. Highlight the cycle and select Edit
9. Fill out the Cycle Invoicing Process according to your company’s setup; below are common settings:
a. Description: leave at default
b. Category: Monitoring (or a similar category)
c. AR Account: leave at default
d. Terms: Due on Receipt
e. Invoice Date: Date of Process
f. Invoice Description: Security Services (or a similar category)
g. Aging Date: Leave as the first of the month. Most terms do not make use of aging date.
h. ACH Hold Date: First of the month
i. Choose the date you wish to charge cards/banks for those customers who are set up for automatic payments
i. Memo: Optional, your company’s preference
10. Save  -  come back and edit the cycle later
or
11. Post  -  finish cycle invoicing and send to the print queue (only Post when you are completely done and ready for invoices to be created)
12. Upon posting, the Apply Cycle Invoicing Credit form will come up
a. Apply credits to invoices within this cycle
b. Close to leave credits on customers’ accounts
Note: You can apply these credits later through the Unapplied Cash/Credit function in the Accounts Receivable Module. Simply highlight the credit, select Apply, choose the invoice to which you’re applying the credit, and save.
[bookmark: _Toc469993094]Process Statements

For Multiple Customers
The Statements function allows users to generate statements for the entire customer database within a set of chosen criteria. When printing invoices, users have the option to print in Invoice/Statement format and choose “Update Last Statement Date” instead of or in addition to using the Statements function. Customers will only be pulled into the statement function if “Print Statements” is chosen in their Customer Setup. If you have a BFIS account, contact Astute to export statements to BFIS for you. 
1. Open the Statements function under Accounts Receivable
a. The aging process will run at this point and may take a few moments. This is also an easy way to age your customer database, even if you do not wish to run statements. 
2. Choose your statement settings
a. Last Statement Date 
i. Defaults to today’s date
ii. Will prevent customers from entering the list who have already received a statement as of the date entered.
b. Create Statements For
i. All Customers
1. Creates statements for all customers, regardless of the amount due on the account. Includes negative balance and zero balance due customers. 
ii. All Non Zero Customers
1. Excludes customers with zero dollars due on their account.
2. Includes customers with negative or positive balances due on their accounts.
iii. AR Balance
1. Choose a minimum balance due per account and a minimum number of days past due to exclude customers that do not fit this criteria.
c. Branch
i. If you have multiple dealers or branches, choose one or more of these
or
ii. Choose “All”
d. Separate Statement by Billing Address
i. If deselected, each customer account will receive one comprehensive statement
ii. If selected, each billing address will receive a statement for the sites assigned to that billing address
e. Filter for Emailing
i. Only check if you are emailing customers with PDFXplode
f. Print Options
These settings should be chosen in Sedona Setup/Late Fee Rules so they will default correctly in the Statement function.
i. Choose a statement date. Choose a due date or check “Hide the Due Date.” If you wish to show the account’s open cash and credits on the statement, click “Show Open Credits.”
ii. Enter statement memos for customers who are over 30, 60, and 90 days past due.
g. Recalculate and Show Late Fees
Late fees can be recalculated and applied to the customers who meet the chosen statement criteria if this option is checked. If you do not wish to apply or change late fees, deselect this checkbox. These settings should be chosen in Sedona Setup/Late Fee Rules so they will default correctly in the Statement function. 
i. Minimum Days Past Due 
ii. As Of: this date will default to today’s date, but you can backdate to exclude invoices, if necessary. 
iii. Minimum Invoice Balance: set to $0.01 to include all invoices. 
iv. Annual Interest Rate: will calculate amount due according to the entered percentage at an annual rate.
v. Minimum Charge: each statement will receive a late fee equal to this amount if the recalculation of the late fee is less than the minimum charge entered here. If you don’t wish to set a minimum charge, enter zero here. 
3. Click on the second tab, Statement List
a. Click Refresh List to show all customers who will receive a statement according to the settings chosen
b. Click Print List to print the current list of customers before creating the statements
c. Click Create Statements when you are ready to print statements and update the customers’ accounts
d. Once this is chosen, you’ll receive the option to click Preview Statements, which will allow you to print

For a Single Customer
[bookmark: _Toc469993095]Statement
1. Open the customer’s account
a. Right click on the bill to address and click Print Statement.
i. This method will show past due invoices connected to this bill to only. 
OR
b. Right click on the Collections folder in the customer tree and click Print Statement.
i. This method will print all balances due for the entire account. 
[image: ]
2. In the Format tab, choose appropriate settings, such as showing late fees or open credits. 
a. Current late fees can be shown on any statement, but cannot be recalculated. If you wish to recalculate late fees, you must do so in Accounts Receivable/Statements or by printing an invoice/statement. 
[bookmark: _Toc469993096]Invoice/Statement
1. Open the customer’s invoice. Then go to File/Print Preview. Choose either Invoice Statement or Bridgestone Standard in the form field. These are the two formats that will show other open invoices on the account. 
[image: ]
2. To include late fees, print an Invoice Statement and check “Show Late Fees” and “Recalculate Late Fees” in the Printing Preferences box.
[image: ]
[bookmark: _Toc469993097]Remove a Late Fee
1. To remove a late fee from one account, right click on the Last Late Fee label at the top right of the header section. 

[image: ]
2. Click Remove Late Fee
3. To remove a late fee for all customers, open the Statements function. Click Recalculate Late Fees and enter zeroes in the calculation fields:
[image: ]
4. Click Refresh List on the next tab and all late fees will be removed from all overdue invoices in the list. 
[bookmark: _Toc329089703][bookmark: _Toc469993098]Manage the Print Invoices Queue
[bookmark: _Toc329089704][bookmark: _Toc469993099]Print Invoices
1. Open Print Invoices in the Accounts Receivable module.
2. Use the filters on this screen to pull the invoices that you want to print. 
[image: ]

3. If printing recently posted cycle invoices, deselect the job, service and other checkboxes. 
4. Select Show Master Cycle Invoices to show only cycles from master accounts.
5. Always have Only Show Invoice in Print Queue selected when you want to view invoices with “Add to Print Queue” checked. Deselect this option to print specific invoices.
6. If you deselect this setting, ALL invoices in your database that match your criteria will be pulled in. If this is what you want to do, select branches, dates, or invoice numbers to search on this specific criteria. 
7. Select Show ACH Pending Invoices to view invoices that have automatic EFT payments pending.
8. Filter by residential or commercial customer invoices or select both. 
9. Select Create List to pull all invoices in the queue according to your selections.

[image: ]

10. From the invoice list displayed, deselect invoices that do not need to be printed.
11. Choose an invoice format from the “Print On” dropdown box.
12. Select Print or Preview to print selected invoices.
13. After printing, select Mark as Printed to permanently remove checked invoices from the print queue.
14. Select Remove from List to temporarily remove these invoices from the queue. They will appear in the list again once you reopen Print Invoices.
[bookmark: _Toc329089705][bookmark: _Toc469993100]Create Miscellaneous Invoices
1. Open the customer explorer
2. In the customer file tree, right click on Invoices under the correct site
3. Select New Invoice
4. Confirm the invoice is for the correct site and billing address 
a. Click on the buttons at the top left of the invoice to change to another site or bill to
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5. Select an appropriate line item, i.e. over the counter part
a. Enter a quantity and rate for this item. Tax will calculate automatically.
b. Repeat as necessary for all invoice items. 
6. If you are charging parts directly to customer, click on the parts tab, then on the ellipsis to search through all parts. 
7. Enter description, invoice date, salesperson, terms, warehouse (if parts are on the invoice), and invoice type.
8. Deselect “Add to Print Queue” to prevent this invoice from going to the print queue
9. Save
[bookmark: _Toc329089706][bookmark: _Toc469993101]Create Credits
1. Right click on the invoice to be credited and select “Create Credit From” to create a credit memo with the same amounts and line items as the invoice. 
or
2. Right click on Credit Memos in the customer’s file tree to start a blank credit memo and chose your own items. 
3. Select New Credit Memo. 
4. Choose a line item that starts with CM for credit memo. 

[image: ]
5. Enter a quantity and rate.
6. Enter notes into the Memo field to explain the reason for the credit request. 
7. Choose a Credit Reason. 
8. Save
[bookmark: _Toc469993102]Apply Credits
1. Right click on the credit from the open items page. 
2. Select apply
3. Click “Auto” to apply the amount of the credit to invoices from oldest to newest or enter amounts in the payment column according to which invoice should be credited. 
4. Choose an apply date.
5. Save
Note: Go to the payment section to see how you can use the Other tab to apply the credit in other ways.
[bookmark: _Toc329089707][bookmark: _Toc469993103]Managing EFT Transactions
[bookmark: _Toc329089708][bookmark: _Toc469993104]Enter a New CC or Bank
1. Right click on Payment Options in the customer file tree
2. Select “Edit Electronic Funds Transfer”
3. From the dropdown, choose either New Bank or New CC
4. Enter account information provided by the customer 
5. Select Recurring for credit cards if this card will automatically pay all cycle invoices
6. Choose Non-recurring only if the customer wishes to use this card to automatically pay all non-recurring invoices (job, service, misc.) up to a set maximum amount. This maximum amount can be entered in the text box that appears under Non-recurring.
7.  Choose a hold day according to the day of the month the card should be charged. Choose a 1 to allow the EFT date to default to whichever day is chosen in Cycle Invoicing as the ACH hold date. 
[image: ]
8. Check Print Cycle Invoices if this customer wishes to receive cycle invoices showing that their card or bank will automatically be charged.
[bookmark: _Toc469993105]Using Auto Draft
The Auto Processing checkbox will determine if this card/bank is charged automatically when invoices are created. If you select the checkbox next to Recurring, a transaction will automatically be submitted each time a cycle invoice is created.  The Print Cycle Invoices checkbox can be deselected when this is chosen so that the customer will not receive a paper invoice from the print queue for auto-payment invoices. The Hold Day option under Auto Processing will determine on which day of the month the transaction should be created. Only one payment method can be designated as an auto processing card per account.
[bookmark: _Toc469993106]For Cycle Invoices
1. Check the Recurring checkbox to designate that a charge should automatically be created for each cycle invoice that is generated on this account. 
2. Enter a number in the Hold Day dropdown
a. The number you enter in the hold day reflects the day of the month you wish to charge the card. For example, entering a 5 here means that the charge will be entered on the 5th of each month/cycle.
b. If you enter a 1 in this dropdown, the card will be charged on the date that is chosen as the ACH Hold Date in the cycle invoicing process each month. Keep in mind that from now on, you will want to pay close attention to the ACH hold date field in Cycle Invoicing. This date will determine when all recurring auto-process cards will be charged if they have a hold day of 1.
i. You should enter a 2 rather than a 1 in the hold day dropdown for customers that want to be charged at the beginning of the month to prevent these customers from being charged automatically on the date chosen in Cycle Invoicing. 

[image: ]

For example, your company may typically generate cycles on the 15th of each month for the next month’s cycle, and you charge all credit cards and banks that are set up for auto process on the first of the next month, meaning you enter a hold day of the 1st into Cycle Invoicing. However, one customer does not want their card to be charged until the 5th of each month. You would therefore choose 5 under the hold day dropdown of the EFT setup form and this customer’s transaction will be created on the 15th of each month, but not submitted/charged until the 5th. All other customers have a 1 in the hold day dropdown of their payment method, so SedonaOffice will look at the hold date in Cycle Invoicing - in this case the 1st - and the card/bank transactions will be submitted on that day.
[bookmark: _Toc469993107]For Job, Service and Miscellaneous Invoices
3. Check Non-Recurring to designate that a charge should automatically be created for every job, service or miscellaneous invoice that is created for this account.
a. When this is checked, a blank box will appear. This field is where you will enter the maximum daily charge on this card/bank for these types of invoices. For example, I have entered 500 to show that the customer does not wish to be charged more than $500 per day when a job, service or miscellaneous invoice is created on their account. 
[bookmark: _Toc469993108]Enter EFT Transactions 
Once all cards and banks are entered, you can begin to submit transactions. This can be done from four different areas within the customer page.
[bookmark: _Toc469993109]From the File Tree
1. Right click on Payment Methods and choose ‘Enter New EFT Transaction’:
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[bookmark: _Toc469993110]From the Payment Method
2. Double click on the card or bank from within Payment Options. 
3. Click on New Transaction at the bottom left.

[image: ]
[bookmark: _Toc469993111]From an Invoice
4. Open an invoice and click on EFT at the bottom right:

[image: ]

[bookmark: _Toc469993112]From the Open Items Page
5. Right click on an invoice and select ‘Make EFT Payment’:
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6. All of these methods will take you to the New EFT Entry form:

[image: ]

7. Select which bank or card you’re charging. 
8. Give the payment a description.
9. Enter a hold date (date the card will be charged), and enter a check number if necessary. 
10. Check each invoice that should be paid in this transaction, or select ‘Pay All Invoices.’ 
11. The total will add up in the amount column. If there are no invoices on the account or you do not wish to pay off one of the existing invoices, check unapplied cash or advance deposit. You also have the option to put the charge toward Miscellaneous Income by choosing a GL Account. If you need to remove a charge from an invoice, first void the charge from within payments gateway, then open this form and select Void. If you are not able to void, you may need to re-invoice. 
[bookmark: _Toc329089710][bookmark: _Toc469993113]Process Customer Payments
[bookmark: _Toc329089711][bookmark: _Toc469993114]Create a New Payment Processing Batch
1. Open the Payment Processing function in Accounts Receivable
2. Select ‘New’ 
3. Complete the New Batch Information form
a. Enter the Tape Total as the sum of all checks being entered
4. Save
5. Highlight the batch you just created and select ‘Enter Payments’ or double click
6. Select the customer (using the search binoculars), payment method, posting date, and check date
7. Enter a check number and, if desired, an invoice number and memo
8. Enter an amount for the payment
9. All invoices currently on the selected customer’s account will appear in the middle of the form. Select ‘Auto’ at the bottom right to pay invoices from oldest to newest up to the amount entered
10. To pay a specific invoice, type in the amount under ‘Payment’ rather than selecting ‘Auto’
11. If there is not yet an invoice on the account, you can click on the Other tab to apply the payment in other ways.
a. Choose Late Fee and enter an amount to apply part of the payment as a late fee that is not included as part of the invoice total:
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b. Choose Unapplied Cash to put cash on the customer’s account that can be applied to an invoice at a later date. Checking future auto apply will apply the amount entered to the next invoice that is created for the customer:
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c. Choose Advance Deposit to apply the payment to an open job that has not yet been invoiced. Select the job number and amount to apply:
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d. Choose Miscellaneous when you want to apply the payment directly to a GL Account. For example, if you cancel a customer and credit off all invoices because you do not expect payment, but then you receive payment later, you can choose a GL Account rather than re-activating the customer:

[image: ]

12. Use the green arrows at the bottom of the form to continue to enter payments until all payments have been entered and the batch balance at the top of the page shows zero. 
13. Save
14. SedonaOffice will ask if you are ready to tag the batch as ready to deposit
15. Select Yes
[bookmark: _Toc329089712][bookmark: _Toc469993115]Deposit a Batch
1. Make sure the Ready checkbox on the far left is checked on the batch you wish to deposit
1. Select Deposit at the bottom right
1. Choose a Deposit Date, Branch, and the Bank Account into which the money was deposited.
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1. Enter a description to label the batch
3. If the batch is for a lockbox, label it accordingly, i.e. LB 01/16/13
1. Select the checkboxes of the batch or batches being deposited
1. Save
1. If you selected ‘Print Deposit Ticket’, the print preview screen will come up. Print your deposit summary, if desired
1. Close out of Payment Processing and go back to refresh the list
Note: You can review deposited batches by selecting the View Deposits button or by checking Show Deposited Batches. 
[bookmark: _Toc329089713][bookmark: _Toc469993116]Process Customer Refunds
1. Open Write Checks in the Accounts Payable module
a. Choose the bank account you are using to refund the customer
b. Check the Customer radio button
c. If you are printing this check, click In Print Queue. If not, fill in a check number from the check you’re manually writing. 
d. Search for the customer and the address will automatically populate. Enter date, amount, and memo.
e. Choose a GL account and category
f. Enter the amount of the check
g. Fill out the Job and Type section if this check is related to a specific job. If not, deselect Show Job Cost
h. Save or Print
Note: To refund a customer’s bank account or credit card, you must complete a refund through your virtual terminal in Payments Gateway. To reflect this refund in SedonaOffice and re-establish the balance of the invoice, you can start a new invoice and use the “Re-Invoice” line item.

[bookmark: _Age_the_SedonaOffice][bookmark: _Toc469993117]Age the SedonaOffice Database 
In SedonaOffice, the aging process must be run in order to update the AR_Customer_Aging table, which contains current balance due amounts and dates for all customer invoices, credit memos, unapplied payments, and late fees.  
This means that databases must be aged on a regular basis to ensure that past due balances are reflected correctly. This affects many areas that pull directly from the AR_Customer_Aging table for current open balance or past due information, including the collections module, aging reports and customer dashboards, among others. 
There are four different ways of aging:
1. Age one account:
a. Right click on Aging in the customer tree.

 [image: ]
b. You should notice that the balance due is updated on the customer’s dashboard: 
[image: ]
2. Age all customers:
a. Open statements:
i. Click on Statements under Accounts Receivable in the company tree. You’ll see the message shown below. Once it disappears, you can close the statements function.
[image: ]
b. Run a current aging report:
c. In Report Manager, open the Current Aging report. Check “Reage All Customers,” then Ok. 
 [image: ]
d. Request that Astute set up an auto aging wizard on your SedonaOffice server
e. This can be set to age your database on a nightly or weekly basis. This method prevents you from having to manually age your own database. 
[bookmark: _Toc469993118]Job Management
Follow this link to watch instructional videos on the Job Management module:
Job Management Playlist
[bookmark: _Toc469993119]Using the Job Queue
The Job Queue is a sorting and filtering system for all jobs within your company. You can view and access all jobs from this list. Double click on a line or select Open at the bottom of the screen to open a job.
[image: ]All Jobs
This button shows all jobs within the criteria designated by the filtering dropdowns on the top of the screen. If all dropdowns are set to all, every open job will be displayed. 
[image: ]Ready to Invoice
This button shows jobs with approved tasks that have been flagged for invoice. If you need to invoice a job and do not see it in this list, go into the Tasks list in the job and flag a task for invoice. 
[image: ]Unscheduled Jobs
	Use this button to quickly find all jobs that still need to be scheduled.  
[image: ]Schedule 
Disregard this button if you are using the appointment function in the job. Use the Appointment Summary instead.
[image: ]Appointment Summary
This button will open a new window where you can view and schedule appointments. Use the dropdown to select a day to view. The Create New…   [image: ]  button will take you to the service module to schedule a new ticket if you select Ticket from the dropdown arrow. If you choose Job, the new job screen will open in a new window. Keep in mind that Perennial has now integrated job scheduling in SedonaScheduler and most companied no longer use the Appointment Summary.
[image: ]Quotewerks
If your company has Quotewerks, this button will open the Orders to Process screen, where you can import jobs.
[bookmark: _Toc469993120]Manage a Job 
[bookmark: _Toc469993121]Create a New Job
[bookmark: _Toc469993122]From the Customer Page
1. Open the customer explorer
2. Expand the Systems folder under the site to which you are adding this job.
[image: ]
3. Right click on Jobs and select New Job.
[bookmark: _Toc469993123]From the Job Queue
1. Open the job queue under Job Management in the company file tree. 
2. Click new at the bottom of the queue. 
3. Search for the customer using the Customer Lookup binoculars. 
[bookmark: _Toc469993124]Work Order
1. Complete the Work Order entry form:
a. Job number, tax group, branch, and salesperson are automatically filled in by SedonaOffice. Make sure to look over these fields and correct if necessary.
b. Enter projected start and end dates if you know when this job will take place. 
c. You do not need to enter a tech under Installer. Tech will be scheduled later in the job.
d. Required fields:	
i. Job Type
ii. Install Company
iii. Sold Date
e. Enter text in the Notes field that reflects the nature of the job, i.e. 2 keypads, 2 motions
f. Apply
[bookmark: _Toc469993125]Job System
Note: Always use an existing system; if there is not an existing system, create one first and then start the new job.
1. To pull in an existing system:
a. [image: ]Deselect the New System checkbox
b. Click on the import button next to System Account 
c. Double click on the system to which you are assigning the job 
d. SedonaOffice will ask if you want to import system information. Select Yes
e. Review all other information for accuracy
f. Apply
[bookmark: _Toc469993126]Tasks
This section displays a list of general tasks that must be completed during the course of the job. This list is customizable in SedonaSetup according to your company’s preferences. Each job type can have a unique task list. Each task has a list of users who can sign off on the task. This will allow you to prevent a job from being scheduled, invoiced, closed, etc. without the appropriate users completing their tasks. Approve tasks as you complete each one. A job can only be closed once all tasks are approved and all items are invoiced.
1. Right click on the first task
2. Select ‘Approve Task’
3. The line will be time stamped and marked with a user name. To reverse the approval, right click on the task and select ‘Unapprove Task.’
4. Tasks must be approved in order. To reorder the list, highlight a task and use the green arrows on the far right side of the screen to move the task within the list.
5. To delete a single task from the current job, highlight a task and select ‘Remove.’
6. To add a task to the job, select ‘New,’ fill out the dropdown options at the bottom of the screen, and select ‘Save.’
7. Tasks that are marked with a ‘Y’ in the Invoice column allow you to create an invoice after they have been approved. You cannot invoice a job until a task marked ‘Y’ for invoicing has been approved.
8. Apply the list before you move on to the next screen.
[bookmark: _Toc469993127]Installs
These items will appear on the invoices generated from this job. 
1. Click ‘New’
2. Choose an appropriate invoice item. If you are charging a flat rate for the install, enter a general item, i.e Install Security System. If you would like to separate the charges (usually for tax purposes) for parts and labor, add one item for parts and one for labor.
3. Choose an appropriate Phase Code
a. Phases are assigned to each task in the task list and to the Install items as a way to prevent a job from being invoiced until all tasks in a specific phase have been approved.
b. Choose different phase codes for different install items to invoice parts of the jobs separately. 
i. For example, imagine a job has two phases, pre-wire and trim. You may create an install item called Advance and assign it to the pre-wire phase. The second item, Job Labor, is assigned to the trim phase. The Advance item may be invoiced right away. As soon as all pre-wire tasks have been approved, the Job Labor item will become available to be invoiced. 
4. Leave Cost Type as is.
5. Enter an appropriate quantity
a. This is applicable when you want to show the customer a specific rate multiplied by the quantity, typically when you are charging for labor. 
6. Enter an amount to charge in the Unit Price
7. Enter Labor Units as the estimated number of hours it will take the tech to complete the job.
a. Double this amount if there will be two techs on the job (triple for three techs, etc.)
8. Save
[bookmark: _Toc469993128]Recurring
1. Required fields:
a. Recurring Item
b. Bill Cycle
c. RMR Amount
2. Save
3. Enter another recurring item if necessary and save each time.
Note: Enter a ‘Sub Item Of’ description if this customer has more than one recurring item and you wish to only show one line item on the invoice. Each item should be grouped under the same Sub Item Of description to group these charges together on the invoice.
4. Apply
[bookmark: _Toc469993129]Materials
[image: ]

1. Click under ‘Part’ and add parts by clicking on the ellipsis button that appears
2. Check ‘Pre-Load Parts’ to load a list of all parts, or use the lookup bar to search for parts by name
3. Hold Ctrl on your keyboard to choose multiple parts to add
4. Select
5. Enter quantities for each part
a. Add identical parts separately if you want to track the location of each part on the site. 
6. In the location column, enter any known location for the part to use later during service calls.
7. Check the Stock checkbox if you do NOT want this item to be added to a PO for this job. The Stock checkbox indicated that 
8. Apply
[bookmark: _Toc469993130]Job Costing
This screen tracks the monetary loss or gain of the job. Update estimated cost amounts through the buttons next to estimated amounts.  [image: ] Check these buttons to pull in available amounts from the job that will give a loss/profit percentage. All actual costs come in automatically from records in the job: 
· Part costs: parts issue
· Labor costs: timesheets
· Other costs: journal entries, AP bills
· Overhead costs: journal entries (set up in Sedona Setup/Job Types)
· Commissions costs: commissions (same as estimated)
[bookmark: _Labor][bookmark: _Toc469993131]Labor
The labor section is used to schedule appointments and enter timesheets for technicians. The Schedule function is a legacy module and exists for customers who still prefer to use it, but should not be used if you are a new SedonaOffice user. All labor will appear in the Appointments section. Job scheduling can be done in this area, or from the SedonaSchedule calendar. Move to the section called Create a Job Appointment if you wish to schedule from SedonaSchedule. 

1. Create an Appointment from Inside the Job:	
a. Right click anywhere in the white space
b. Select ‘Add New Appointment’
c. Choose the date you wish to schedule the job in the ‘Current Date’ field
d. Fill in the ‘Tech’ and ‘Time’ fields or double click on the schedule on the correct time under the tech’s column
e. Enter estimated length in minutes according to your approximation of how long the job will take to complete
f. Choose the technician’s task in the Job Task dropdown. This is often called ‘Do the Work’ or ‘Work’
g. Labor Task can be left blank
h. Apply
i. Repeat steps if there is more than one tech on the job

Note: Timesheets can be manually entered if necessary as described below. However, most companies prefer timesheets to be automatically generated using the information entered into the appointment. If you wish to set up automatic timesheets, follow the instructions below.

2. Manually Enter a Timesheet:
a. Select ‘New’
b. Make sure the date, installer and pay rate are correct 
c. Change the Job Task to ‘Do the Work’
d. Enter units as the number of hours spent on the job
e. Add
f. Repeat steps if there was more than one tech on the job
[bookmark: _Toc469993132]Create a Job Appointment
1. To schedule a job appointment from SedonaSchedule, change from the service wrench icon to the jobs hammer icon (the clock icon is for scheduling miscellaneous appointments) in the ribbon. 
[image: ]
2. Once this change is made, you can double click on the calendar to schedule a job instead of a ticket. 
3. Choose the job you’re scheduling for and click Select:
[image: ]
4. Choose the job task you have assigned to the tech, usually “Do the Work” or “Work”. 
a. You should choose the same task each time. Labor tasks are only used for miscellaneous appointments, so leave this field blank. 
5. Choose a time and date for this appointment. 
a. You can highlight multiple dates, which will create multiple appointments, but keep in mind that the same start and end times will be used for each date. 
6. Click Schedule to create the appointment(s). 

[image: ]

[bookmark: _Toc469993133]Complete the Appointment
From Labor/Appointments
1. Right click on the appointment inside the job in Labor/Appointments
2. Choose ‘Edit Appointment’
3. Click ‘Dispatch’
4. Complete each time field: dispatched, arrived, departed
a.  The date and time must be in the correct format: 1/15/2015 12:00 PM
5. Save
a.  If you have automatic timesheets activated, the timesheet will be created for you after the appointment times are entered. If you are not using automatic timesheets, go here for directions on entering the timesheet.
From SedonaSchedule
1. Open SedonaSchedule and find the appointment on the calendar
2. Click once on the appointment
3. Click ‘Edit’ on the grey panel on the left side of the Scheduler 
4. Complete each time field: dispatched, arrived, departed
5. Save
a. If you have automatic timesheets activated, the timesheet will be created for you after the appointment times are entered. If you are not using automatic timesheets, go here for directions on entering the timesheet.
[bookmark: _Toc469993134]Tools
This screen allows you to track actions taken on this job in the Log screen and makes comments pertinent to the job in the Notes screen. Tools is also where you will manage parts being added to this system. The Invoicing button shows all invoices associated with this job, but will not allow editing from this area.
1. Purchase Orders
a. To purchase parts for a job, right click anywhere in the white space in Tools/Purchase Orders
b. Select ‘Create PO’
c. Select the correct vendor if more than one appears
d. The purchase order will open 
i. Parts will automatically load based on information in the materials list. Only parts with this vendor chosen and “Stock” deselected in the Materials list will load onto the PO. You can add additional parts manually to the PO.
e. Choose the correct category and order date
f. OK
2. Receiving a PO:
a. In the company file tree, under Accounts Payable, select Purchase Orders
b. Choose a vendor from the dropdown
c. Click once on the PO from the job you are working on
d. Click ‘Receive’ at the bottom right  side of the screen
e. Check that the PO has all the correct parts 
f. Save
i. The PO has been fully received if it disappears from the list after this step. Go here for more information about receiving parts. 
3. Issue Parts
a. Under Tools in the job, select the ‘Issue Parts’ button
b. Choose the correct warehouse from the dropdown
c. Parts not yet issued will automatically populate in the list
d. Issue Date: choose the date the parts are being installed onto the site/pulled from the warehouse
e. Apply
[bookmark: _Return_Parts_through][bookmark: _Toc469993135]Return Parts through a Job
[bookmark: _Toc426116367][bookmark: _Toc469993136]Option 1: Return from Inventory>Issues/Returns 
1. Expand the Inventory menu and click on Issues/Returns
2. Choose the return type, i.e. Job, Service, Other
3. Choose the warehouse to which you will be returning the parts
4. If you chose a return type of job, enter the job number to correct the part counts in that job
5. Complete the remaining areas with appropriate information
a. Phase Code (optional)
b. Memo (optional)
c. Issue Date
d. Category – this is usually a J-system/job type category. Go to Sedona Setup/Job Types to determine which category the job type is using. 
e. In holding & holding location – this is typically only used for parts issues, not returns (optional)
6. Check “Return to Stock”
a. All parts issued to the job will automatically load at this point. 
7. If necessary, change part quantities to reflect which parts you will be removing from the job and returning to stock. 
a. You can use the “Set All Qty to 0” button at the bottom of the screen to make this easier. 
b. If you are returning all parts on the job, do not change quantities.
8. When the quantities accurately reflect what is going BACK INTO the warehouse chosen, click save.
9. This process will create a return in Tools>Issue Parts inside the job. 
[bookmark: _Toc426116368][bookmark: _Toc469993137]Option 2: Return from inside a job
1. Open the job and go to Tools>Issue Parts
2. Double click on the original issue in the “Previous Issues” section to open it
3. Check “Return to Stock” at the top of the screen
a. Part quantities will turn red to indicate they are being returned instead of issued 
4. If necessary, change part quantities to reflect which parts you will be removing from the job and returning to stock. 
a. If you are returning all parts on the job, do not change quantities.
5. If necessary, edit the return date. If the original issue date is in a closed accounting period, you must change the return date. 
6. When the quantities accurately reflect what is going BACK INTO the warehouse chosen, click apply.
[bookmark: _Toc469993138]Billing
Once you have approved a task that is flagged for invoice, you have the option to invoice part or all of the job. Each ‘Y‘ in the Invoice column of the tasks list will create another opportunity in the job queue to invoice the job until all charges have been included on an invoice. SedonaOffice will not allow a user to over-invoice a job.
1. To bill for install amount only:
a. In the job queue, select the Ready to Invoice button  [image: ] at the top of the screen
b. Double click on the job you wish to invoice
c. Deselect ‘Bill RMR’
d. Change the invoice date and terms if necessary
e. Enter an appropriate description, i.e. Installation
f. Enter an explanation in the Memo field, i.e. First half of burg installation
g. If this customer is being partially billed, change the quantity in the line item according to the amount of times this customer will be billed for this job, i.e. from 1 to .5 or .33
i. The amount will automatically change to match this quantity
ii. If you would like to charge the customer a flat rate, change the Rate line rather than Quantity
h. Save
i. Repeat these steps until the entire amount of the install has been invoiced
2. To bill the RMR:
a. In the job queue, select the Ready to Invoice button  [image: ]  at the top of the screen
b. Double click on the job you wish to invoice
c. Choose RMR Reason (usually New RMR)
i. The reason often changes based on the job type. Be consistent with the reasons being chosen as this will be used by all RMR reporting.
d. Enter the Activation Date and the Next Cycle Date
i. Typically, the activation date is the date the system started monitoring at the central station, and the next cycle date is when the RMR should show up in regular cycle billing.
ii. The invoice will automatically prorate the RMR amount based on the activation date and the next cycle date chosen. Always check the quantity on the RMR line item to be sure you are billing the customer for the appropriate number of months.
e. Select or deselect “Add to Print Queue” depending on whether you want to print the invoice or not.
f. Save
[bookmark: _Toc469993139]Adding a Change Order
When job invoices are credited off using “Create Credit From,” all install items on that invoice can automatically be rebilled. However, changes cannot be made to these items in the job. If the job totals are wrong, or you need to remove RMR so you can rebill it, you will have to add a positive or negative change order to correct the job.
1. To add a change order, first lock the job by approving a task in the Task List that has “sequence locks job” checked. You may want to add a task specifically for this purpose:

[image: ]

2. Once the new task is approved, the “Add Change Order” button will appear in the Tools tab.
3. Complete the work order with appropriate information. If you are removing items from the job, check Manual Reversal. If you are adding items, leave Manual Reversal deselected. 

[image: ]    [image: ]

4. Click Apply.
5. You can now add or remove materials, commissions, install items and recurring items. When removing an item, make sure to choose the same item as was chosen in the original job. This is the only way the job will recognize that an existing item has been removed. 
6. Make sure to use negative quantities in manual reversal change orders. 
7. Go to the Sales Summary in the job to confirm that the totals are correct after you have added the change order.  
[bookmark: _Toc469993140]Job Closing Rules:
1. Review the Sales Summary screen to ensure there is not a Balance to Bill.
2. To avoid having to reopen jobs, review the Job Costing screen carefully.
I. NOTE: It’s also good practice to compare the final entries in the job (price, parts, commissions, etc.) to the sales documents.
3. Close jobs using the current date
I. NOTE: There is usually no need to back-date the closing date because the job accrual can be used to recognize revenue and costs on jobs that were in progress or complete at month-end
II. EXCEPTION: The closing date may be backdated to a prior month only if all invoices and cost transactions incurred and booked in the prior month.  While not recommended, this practice may be useful if you are not doing a month-end job accrual.
4. Close a reopened job using the same date that the job was originally closed
I. IMPORTANT: Avoid entering transactions (invoices, parts issuances, tech time entries, commission entries, other costs charged through A/P) in months subsequent to the original closing date.  If this cannot be avoided and transactions are entered in months subsequent to the original closing date, journal entries must be used to properly match revenue and costs in one of the months
5. Other:
I. Rather than reopening a job, consider the alternative of creating a new job or service ticket to account for additional work
II. Do not close a job if there is any question that it is incomplete
III. Make it a standard month-end accounting procedure to review the Reopened jobs queue and to close all Reopened jobs in accordance with these guidelines
IV. Always create credit memos for jobs from the job invoice using the Create Credit From option on the right-click menu. 
[bookmark: _Toc469993141]Service Management
Follow this link to watch instructional videos on the Service Management module:
Service Management Playlist
[bookmark: _Toc469993142]Navigate the Service Interface
To open the service module, simply click on Service in the company file tree. The new service module will open in a new window. 
[bookmark: _Toc469993143]Calendar
The left hand side of the service module shows the calendar for technicians. Use the calendar to search for service tickets.
1. Use the calendar at the top left of the service screen to choose a day or multiple days to display in the schedule
2. Click on a date on the calendar and drag through another date to show multiple days at once in the schedule
3. Dates in bold have service tickets scheduled on those days
[bookmark: _Toc469993144]Detail Tab
1. This tab can be found at the very bottom left of the service module screen
2. Click on a ticket to activate the information in this tab
3. When a ticket it clicked one time, known details of this service ticket will be displayed on the left side of the screen including:
a. Site
b. System
c. Contact info
d. Problem
e. Technician
f. Scheduled times
4. Edit
a. Click this button to change or enter:
i. Schedule times
ii. Technician
iii. Resolution
5. Notes
a. Click this button to view any notes that have been entered into this service ticket
[bookmark: _Toc469993145]Unscheduled Tab
1. Click this tab to show all tickets that have been created, but not yet scheduled
a. Double click on one of these tickets to open the ticket and schedule an appointment
2. Click the Inspections checkbox to show unscheduled inspections
[bookmark: _Toc469993146]Schedule 
[bookmark: _Toc469993147]Changing a Ticket
1. Drag a ticket between sections to change which technician will be performing the service
2. Grab the edge of the service ticket and push up or pull down to change the amount of time a service call is scheduled for in the calendar
[bookmark: _Toc469993148]Using the unassigned technician column    
This column shows tickets that have been scheduled, but not yet assigned to a specific technician. Use the Unassigned technician to keep track of service tickets when you are not able to give them to a technician, but the customer needs to get on the schedule.
[bookmark: _Toc469993149]Service Ribbon 
[bookmark: _Toc469993150]Navigation
1. Show/Hide the Calendar Bar
a. Click this button to make the calendar bar disappear and reappear
2. Today
a. Click this button to show only today’s schedule
[bookmark: _Toc469993151]Arrangement
1. Day/Week/Month
Click each of these functions to expand the schedule to show either a day, week or month at a time under each individual technician’s schedule
2. Queue
Drag headers from side to side to reorder the service ticket info. Drag a header up to the gray bar to group tickets according to certain criteria. Switch to queue view to get a list of service tickets according to selected criteria. This can be chosen by selecting Queue under arrangement and then the Queue tab directly above. Choose the criteria listed according to the tickets you wish to view, including open tickets, tickets with a scheduled appointment, tickets that have not been scheduled, go back tickets, resolved and  unresolved tickets, and closed tickets.
3. Inspection Creation
Note: Inspections cannot be created through the service module. Inspections must first be created through the customer page. System < Edit System < Inspections < New.
Click this button to search for inspections. Choose search criteria from the dropdowns on the right side of the ribbon. Choose Get Inspections to populate a list of inspections. Choose the inspection to be scheduled by clicking the checkbox and pressing Create Tickets. The inspection will disappear from this list and move to the Queue, where you can complete the ticket for this inspection as usual.
4. Removed Parts
This list shows all parts removed during service calls within the dates selected in the calendar. Drag along the calendar to highlight desired dates and the removed parts list will automatically populate.
5. Miscellaneous Appointments
This button shows a list of scheduled times on the calendar that can be categorized as holiday, lunch, meeting, sick time, vacation, other or miscellaneous. From the Miscellaneous Appointments tab, you can schedule miscellaneous time for techs or edit existing appointments. 
[bookmark: _Toc469993152]Display Group
This section controls which techs are shown in the schedule. The Display Group Edit button shown below allows you to create groups with only certain technicians. For example, you could create separate groups for techs and installers and assign appropriate employees to each group.
              [image: C:\Users\jayme\AppData\Local\Temp\SNAGHTML1d967a1.PNG]
[bookmark: _Toc469993153]Sedona Monitor
This section of the ribbon alerts you when the scheduled date for a ticket has passed and no dispatched time has been entered. The Warning Count function easily shows how many of these tickets need attention. Use the dropdown to view these expired tickets. 
[bookmark: _Toc469993154]Tools
Use this lookup bar to search for a ticket number and bring up a list of available service tickets that need to be closed.
[bookmark: _Toc469993155]Create a New Service Ticket
[bookmark: _Toc469993156]From the customer page: 
1. Open the customer page
2. Right click on Service in the customer file tree and select ‘New Service Ticket’
3. Begin to fill out the new service ticket that pops up. 
[bookmark: _Toc469993157]From the service calendar:
1. Click on Service in the company file tree. The service module will open. 
2.  Find and click on the date you would like to schedule for in the small calendar at the top left of the service module. 
3. Double click in the schedule under the technician’s name at the time you would like to schedule the appointment. Make sure before you double click that the wrench icon is chosen in the service ribbon. 
4. Search for the customer in the lookup screen that opens. The service ticket will then appear.
[bookmark: _Complete_the_service][bookmark: _Toc469993158]Complete the service ticket:
1. Bold items are required fields. Be sure to include the nature of the service in the Comments section.
2. Select Save to make all other buttons in the ticket’s ribbon available.
3. Fill out any custom fields necessary. Custom Fields can be filled with any desired information your company wishes to keep track of through SedonaSetup.
4. If you started the ticket by double clicking on the calendar, the appointment will already be in the Appointments and Labor tab. Double click on the appointment to edit the time or tech. 
5. If you started the ticket from the customer page, click on the Appointments and Labor button, and then click the New Appointment button [image: ]  at the top of the ticket to open the calendar.
6. In the Calendar View, choose the day the appointment needs to be scheduled.
7. Double click on the time of day under the technician to schedule the ticket.
8. SedonaOffice will ask if you are sure this is the day, time and tech you wish to schedule. If so, click Yes
9. The appointment will now appear in the calendar and in the Appointments and Labor tab.
10. Double click on this line to open the dispatch screen.
11. Enter the estimated length in minutes to block the schedule for the correct amount of time.
12. After the service call has been completed, fill in arrival and departure times. If your company charges for or tracks travel, fill in the Dispatched line.
[bookmark: _Toc469993159]Add Parts to a Ticket:
1. Click on the Equipment and Parts tab. 
a. All parts in the top section, Customer Equipment Detail, are parts currently held at this site. Click the X under the Removal column to take a part off of this list.
b. To add equipment, select New at the bottom of the screen.
c. Search for the part by clicking on the box to the right of the Part field, which will bring up your part lookup screen. You can also type in this field if you know the exact part code. Add a location for future reference, if applicable. All other fields should fill in automatically if correctly entered into the part setup. 

[image: cid:image003.jpg@01CF6E02.8C5C1A70]

d. Fill in the location area, if pertinent.
e. Check stock to remove the item from inventory. 
f. Use the technician dropdown to choose the warehouse from which to remove the parts. This dropdown is controlled by the parts warehouse default in the Service Options tab at the top of your service module. If left on Warehouse, the dropdown will show all warehouse names. If left on Technician, the dropdown will show all tech names and default to the tech first assigned to the ticket. The part will be removed from the warehouse assigned to that technician in Sedona Setup. 

[image: C:\Users\jayme\AppData\Local\Temp\SNAGHTML392339.PNG]

g. Click Save to add the part to the ticket. 
h. Save
[bookmark: _Toc469993160]Reschedule an appointment:
1. Job appointments and service tickets can be dragged to different days and times from the calendar. Click on the job appointment and pull to another part of the calendar to change the scheduled time or date.
[image: cid:image006.jpg@01CF6AD4.DB3D4370]
2. To delete the job appointment, click once on the appointment in the calendar, then click delete on the keyboard.
[image: cid:image008.png@01CF6AD4.DB3D4370]
[bookmark: _Toc469993161]Clock out/clock in feature:
Note: Dispatched and arrival times must be entered into the appointment before the clock in/out options will appear.
1. Right click on the appointment in progress and choose a clock out reason and time on the form provided.
[image: ]
2. Click “Clock Out” 
a. This will create a miscellaneous appointment which extends until the end of the original appointment set by the estimated length field. 
[image: ]
3. If an incorrect time was entered, double click on the new miscellaneous appointment to open the edit form. Click the delete button to remove the miscellaneous appointment. Repeat step one above.  
4. Right click on the miscellaneous appointment and complete the clock in form. 
5. Click “Clock In”
 
[image: ]

6. This will create a second appointment for this job or service ticket with a new arrival time. A final departure time should be entered here to complete this appointment. 

[image: ]
[bookmark: _Toc469993162]Print Service Tickets
[bookmark: _Toc469993163]Print one ticket:
a. Open the service ticket
b. Click on the wrench at the top left of the service ticket  [image: ]
c. Select Print
d. Select the correct printer and appropriate options for your service ticket
e. Click OK to view the ticket before printing
[bookmark: _Toc469993164]Print multiple tickets:
f. In the company file tree, open the Service folder
g. Click once on Print Service Tickets
h. Search for tickets using the available criteria
i. Click Create List
j. In the Ticket List tab, check tickets that you wish to print
k. Select Print
l. Select appropriate printing options and select OK
[bookmark: _Toc469993165]Print a report of tickets:
There are two ways to print a list of service tickets. 
1. Open the service module and click on the ticket queue. Before printing, make sure your ticket queue is organized. 
a. Drag and drop the headers to reorder or click the “funnel” to filter by that header. 
b. Click on the Field Chooser at the top left corner of the queue and deselect the headers you do not wish to display. 
c. Drag headers into the grey panel above the queue to group by a certain criteria. 
d. Choose the search criteria for the queue from the buttons in the ribbon, e.g. open, appointment, go back, etc. 
e. 
f. Once your queue is organized, click on “Export to Excel.” You can save the document or print at this point. 
 [image: cid:image001.png@01CFA0EE.248B18F0]

2. Print the “Technician Schedule” report from the service section of Report Manager. This report will show jobs and service tickets, can be filtered by open or closed, and will show each tech on a separate page. 
[bookmark: _Toc469993166]Bill a Service Ticket
1. Open the appointment in the ticket from the Appointments and Labor section
2. Double click on the appointment
3. Check ‘Resolves Ticket.’ Choose a resolution with a Y under Billable to charge the customer or an N under Billable if you do not want to charge for this service call 
Note: If the tech needs another appointment to finish the service call, check ‘Put In Go Back Queue’ instead of ‘Resolves Ticket.’ You can then add another appointment to the same ticket as many times as needed to complete the service and check ‘Resolves Ticket’ on the final appointment.
4. Add text in the Notes field with pertinent information to this service ticket
5. Move to the Billing screen to change billing information. If the Ticket Charges section is incorrect, choose ‘Override Warranty’ or ‘Override Service Level’ to charge the customer
6. Select ‘Create Invoice’
Note: Charges for added equipment will be added to the billing screen under parts. If labor charges are incorrect, check ‘Manual Labor’ in the Appointments and Labor screen to manually change labor amounts.
a. The invoice will open outside of the Service module in SedonaOffice
b. If the billing needs to be changed, open the invoice and select the delete data button in the toolbar. Then go back into the service ticket, correct the billing and then select ‘Create Invoice’ again.
7. When all areas of the ticket are complete, check the Close checkbox from any screen
8. Save
[bookmark: _Toc414874583][bookmark: _Toc469993167]Create and Manage Inspections
Note: All inspections are done through service. You’ll see the option at the top ribbon to create inspections, but first you’ll want to make sure that your customers have inspections set up on their accounts. 
1. Open the customer explorer
1. Right click on the system that will be inspected
1. Select Edit System
1. From the Inspections tab, select New
1. Complete the System Inspections screen with all necessary information
4. Required Fields:
0. Description
0. Frequency
1. Frequency and Next Inspection date determine when and how often the customer will show up in the inspections area of the service. The next inspection date will be reset based on the frequency each time a ticket is created. The “ByRequestOnly” frequency will not automatically pull the inspection item into service, though all other frequencies will. If you use By Request Only, you must come back to the inspection item and reset the frequency before creating the ticket. 
0. Service Problem Code
2. Most companies create an inspection problem code for this purpose.
0. Service Level
3. Most companies create service levels called Inspection – T&M and Inspection – Contract so these tickets will bill correctly by default.
0. Service Company
4. The service company controls the default category, COGS account, and labor setup. If any of these settings are different for inspections than for regular service, make sure to create an inspection company in Sedona Setup/Service Companies. 
0. Next Inspection Date
5. Set the date you want this inspection to appear in the service module. This date will always be based off the original next inspection date plus the frequency. If you create an inspection appointment with a date that is not close to the next inspection date, you will have to go into the inspection item and change it so that it is correct next time. 
0. Estimated Hours
4. Optional Fields: 
1. Charges 
0. This area will add the invoice item chosen to the “Other Items” tab of the service ticket. This area can be used to add any charge necessary to the ticket. Many companies use this to charge the recurring item rather than allowing the RMR item to cycle separately from the ticket. 
1. Service Tech
1. You can assign a service tech to populate each time this inspection ticket is created. If this varies, leave this field blank. 
1. Last Inspection
1. Notes
Note: You can save an inspection without completing the Next Inspection field, but the inspection will not be available for creation from the service module. You must return to the customer and enter this date to schedule the ticket.

1. Open Sedona Schedule 
1. Select the ‘Inspection Creation’ button in the ribbon
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1. Choose a ‘Due As Of’ date and any other desired information from the dropdowns in the ribbon to search for the inspection
1. Click ‘Get Inspections’
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1. Select your inspection by clicking inside the checkbox on the left
1. Click ‘Create Tickets’ in the ribbon
10. The inspection will disappear from this list and move into the ticket queue. From the open items screen in the customer explorer, you can see that this customer now has an open service ticket on their account. Open the ticket from this page or search for the ticket in the queue tab by changing the search criteria from service tickets to inspections. You can also find the ticket in the unscheduled tickets tab.
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11. Complete the ticket as described in the instructions above.

[bookmark: _Toc469993168]Purchase Orders & Inventory
Follow this link to watch instructional videos on the Accounts Payable and Inventory modules:
Purchase Orders & Inventory Playlist
[bookmark: _Toc469993169]Create a Purchase Order
Note:  At the top of the purchase orders list, choose all vendors and then New to choose a vendor from within the PO. Choose a specific vendor at the top of the purchase order list to automatically create a PO for that vendor.
1. Open the Purchase Orders function in the Accounts Payable module
2. Select New
3. Choose a vendor, category and warehouse from the dropdowns at the top of the PO
4. Order Date will default to today’s date. Change if necessary
5. Enter Ship Date, Method and Parts Due Date if this information is known
6. Apply this PO to a job only if all parts in this PO are being used for this job. Select the job using the binoculars under Costing
7. Use the ellipsis to enter parts
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8. When the Print Now button is checked, the Printing Preferences screen will open after closing out of the PO
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9. Click OK
[bookmark: _Receive_Parts][bookmark: _Toc469993170]Receive Parts
Note: If this receipt has a purchase order already entered in SedonaOffice, right click on the PO from the vendor’s page and select Receive Purchase Order so that the receipt will automatically populate with the parts from the PO or follow the instructions below.
1. From the vendor’s page, right click on Receipts 
2. Select New Receipts
3. Sedona will ask if you would like to choose from an existing list of PO’s or returns
4. Select Yes
5. Double click on the PO or repair order you are receiving
6. All parts and information will automatically load
7. Receive Date will default to the current date. Change if necessary
8. Change amounts in the expense tab if charges are different in SedonaOffice than on the receipt from the vendor
9. Save
10. To create a partial receipt, simple edit the quantity column for each part. If you only want to receive one part on that PO, change the quantity of all OTHER parts on the receipt to 0. Or if a partial amount of the parts came in, such as 10 out of 20, change the quantity to reflect what came in. The PO will recognize these changes and stay open until all parts are received. Some users prefer to delete lines rather than to zero them out. If that's you, highlight the line by clicking on the grey box to the left of the part code. The entire line will turn blue. Then click the delete button on your keyboard.

[bookmark: _Toc469993171]Return Parts to Stock
1. Expand the Inventory menu and click on Issues/Returns
2. Choose the return type ‘Other’
a. Note: Click here for more directions on returning parts from a job. Service parts must be returned inside the service ticket. 
3. Choose the warehouse to which you will be returning the parts
4. Complete the remaining areas with appropriate information
a. Reference (optional)
b. Issue Date
c. Category 
d. Cost of Goods Sold GL account
5. Check “Return to Stock”
6. Type or search for part numbers in the Part section and enter the correct quantities. 
7. When the quantities accurately reflect what is going back into the warehouse chosen, click save.
[bookmark: _Toc469993172]Break Out a Kit
1. Open the Parts function in the Inventory module
2. Double click on the kit
3. In the part’s page, open the Warehouses function
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4. Right click on the warehouse the part is from
5. Select Break Out Kit
6. Choose the warehouse, date and quantity to break out
7. Save
Note: The basic vendor information snapshot in the top section of the explorer will now show that the on hand amount of the kit has decreased by one.
[bookmark: _Toc469993173]Process Return/Repair Orders
[bookmark: _Toc469993174]Repair Orders
1. Click on the Repair Orders function in the Inventory module
2. Choose a vendor
3. Select New
4. Enter category and warehouse
5. If needed, enter a Due Date
6. Use the ellipsis button to select a part to be repaired
7. Use the arrow button under the Expenses tab to add miscellaneous expenses related to the repair order
8. Enter a memo to appear on the repair order if necessary
9. Print the repair order using the print preview button in the toolbar
10. Save
[bookmark: _Toc469993175]Return to Vendor
1. Click on the Return to Vendor function under the Inventory module
2. Choose a vendor, reference number and memo (optional)
3. Select a part to return and complete the form
4. Save
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1. Re-open the return order from the vendor’s page
a. Open the Accounts Payable module, then the Vendors function
b. Double click on the vendor to open the vendor’s explorer
2. Click on Returns in the file tree
3. Double click on the return order to open it
4. You now have the option to create a vendor credit from this return order
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5. Select Save to automatically open the vendor credit
Note: See the Accounts Payable training document for instructions on entering a vendor credit.
[bookmark: _Toc469993176]Complete a Warehouse Transfer
1. Go to Inventory/Transfers
1. Click “New” at the bottom to start the transfer form
1. You must enter a request date, but the in process date and shipped date are designed for transfers between branches. These dates can be left blank if you are transferring between a warehouse and a truck, or the dates do not apply for any reason. 
1. If you choose to enter dates here, the status will be updated to match the date field you have entered. For example, when you enter the in process date, the status will change to “In Process.” When you enter the shipped date, the status will change to “Shipped.” You should leave the transfer open, updating these date fields as necessary until the second branch can receive and close the transfer. 
1. For Job/Service
2. You may reference a job or service ticket number, but this field is informational only and will not affect the job or ticket. 
1. Manual Transfer
3. Choose this option to build your own list of parts to transfer. 
3. Search for a part code and enter the transfer quantity at the bottom of the transfer request form.
3. Click Add after typing each part code. Do this for each part that you wish to transfer until the list of parts is complete.
1. Min/Max Transfer
4. Choose either option to transfer a predetermined list of parts and quantities. This is based on the minimum or maximum quantities you have saved for each warehouse in the part code setup. This is especially useful when transferring to trucks on a regular basis because it will prevent you from having to build the transfer list from scratch each time. 
1. Save
5. Before saving the list, take note of parts in red. These parts do not have a high enough quantity in the source warehouse to complete the transfer. You can save the transfer with these parts, but they must be in stock or removed before the transfer can be completed. 
5. Once you click save, the transfer will be saved in the Transfer Requests area. You must click “Receive” to complete the parts transfer. 
5. You may go back into any transfer after saving and delete it before receiving if necessary. 
1. Save/Receive
6. Click this option to immediately complete the transfer. 
[image: cid:image001.png@01D060C9.7E840A60]
1. Receive Transfer Request
7. Review the parts in this list before completing. If any parts have a higher requested quantity than source quantity, you will not be able to save. Change the amounts in the Received Quantity column to move on. 
7. Choose the date of transfer. 
7. Click Save to close the transfer and move parts between warehouses. 
   [image: cid:image002.png@01D060C9.7E840A60]
[bookmark: _Toc469993177]Enter a Stock Adjustment
1. Open Inventory/Parts from the company tree
2. Search for the part and double click on it to open the part page
3. Right click on the warehouse name
4. Click Stock Adjustment
5. Complete the adjustment form
a. Adjustment Date: typically this date should be set to the current date. 
i. Stock adjustments from the part page will adjust inventory to the amount entered in the New Quantity field as of the current date, regardless of the date you place in the Adjustment Date field. Backdating the adjustment date will only create whichever entry is necessary on that date for SedonaOffice to reach the New Quantity as of the current date.
ii. [bookmark: _GoBack] For example, part BK-2WB KIT had a quantity of 10 as of 12/1/2015. 10 more were added to stock on 2/17/16 for an on hand quantity of 20. 
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iii. Then a stock adjustment was performed and backdated to 2/3/16. 
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iv. The adjustment is added to the journal as of 2/3, but the on hand quantity is changed to 15 as of the current date. That means a -5 adjustment is made to account for the current on hand quantity of 15. 
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b. New Quantity: correct quantity as of today 
c. Value: this field will auto-calculate based on the current standard cost for the warehouse being adjusted. Correct standard cost before making this adjustment if necessary.
d. Account Code: for most companies, this will default to 580112 COS – Parts O/H (Count Variance). This can be changed to any COGS account. 
e. Category Code: chosen according to company accounting rules.
f. Memo: optional
[bookmark: _Toc469993178]Use the Suggested PO List
1. Click on the Suggested PO List in the Accounts Payable module
2. From the dropdowns, choose a vendor, warehouse, and product if desired
3. Click the Bring to Minimum or Bring to Maximum radio button (Min and Max amounts are determined in part setup)
4. Click the green arrow to find all parts within the criteria  [image: ]
5. Click “Create PO” at the bottom to start a PO for these parts
a. You must choose one vendor to receive the Create PO option

[bookmark: _Toc469993179]Accounts Payable
Follow this link to watch instructional videos on the Accounts Payable module:
Accounts Payable Playlist
[bookmark: _Toc469993180]Enter Vendor Bills
[bookmark: _Toc469993181]Create a Vendor Bill
1. Click on Bills under Accounts Payable in the company file tree.
2. Choose a vendor from the dropdown at the top left corner.
3. If this vendor has any open PO receipts, you will be prompted to choose one. Click Yes and double click on the correct receipt if this bill has a corresponding PO and receipt. Click No if you are starting a bill without a corresponding receipt.
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4. Enter a reference number, typically matching the vendor invoice number
5. Enter all other known information and update costs on parts, if necessary
a. If costs on parts are changed, the Amount field also needs to be manually updated. When costs are changed on the bill, the vendor cost on the part setup page will be changed as well after you click Apply. Changes in part costs using this method do not update standard cost. Contact support@astutefinancial.biz if you need to update standard costs to reflect changes in part costs from bills.
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6. If the bill is using a parts receipt, parts will load automatically. If the bill does not have a receipt, individual parts cannot be entered onto the bill. The expense tab must be used.
7. Add expenses to the Expense tab in the bill. Update the amount field at the top of the bill to match the total shown at the bottom.
8. For expenses not related to jobs, use 580xxx accounts in the expense tab to create the bill. Several accounts can be used to break the bill into multiple amounts.
[bookmark: _Toc469993182]Job Costing on Bills 
1. Use the costing search box to enter a job onto the bill. This will enter all parts and expenses from this bill onto the chosen job.
2. If the bill has expenses, but no parts, you can enter the job number in the job costing area of each expense line. Each expense can be designated to a different job. If this method is used to show costs on multiple jobs, do not enter a job number into the search box above. That area is used to apply an entire bill to one job. 
3. When job numbers are entered onto the bill, make sure to choose a type of ‘WIP’ (Work In Progress). Other expenses can be given a type of ‘Other.’
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4. For expenses related to jobs, use 510xxx accounts. 
[bookmark: _Toc469993183]Recurring Bill
1. Select the Recurring Bill checkbox in the top right corner of the bill to put this bill into the Recurring Items function. You can later change the frequency and future due dates from the Recurring Items function.
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[bookmark: _Toc469993184]Create and Apply a Vendor Credit
[bookmark: _Toc469993185]Create a Vendor Credit
Note: If the credit was given because of a parts return, open the return from the vendor page and check Create Vendor Credit to automatically create a return related to these parts. If there is no parts return, follow the instructions below.
1. Expense tab
a. Open the vendor page
b. Right click on Credits and select New Credit
c. Choose a category
d. Enter pertinent information from the vendor in the Reference # field
e. Choose a Branch, amount of credit, and date
f. In the Costing field, use the binoculars to search for a job if the credit is related to a job
g. If necessary, change the GL Account
h. Enter an amount to credit
2. Parts tab
a. Parts will be loaded automatically in this tab if the credit is created from a parts return
[bookmark: _Toc469993186]Apply a Vendor Credit
1. Open the Pay Bills function:
a. Search by Branch, Vendor and Due Date to pull up a list of vendor bills
b. In the Vendor Bills tab, select the bills being paid
c. In the Vendor Credits tab, select the credits to be applied
i. Credits will automatically subtract from the total amount, which will show at the bottom of the screen
d. Save
[image: ]               [image: ]
Note: To apply a credit from the vendor’s page, right click on the credit and select Apply Credits. The Pay Bills function will automatically open and the above instructions can then be followed.
[bookmark: _Toc469993187]Pay Vendor Bills
1. Open the Pay Bills function under Accounts Payable.
2. Selection Information
3. Filter the list by choosing Branch, Vendor and As of Due Date. This criteria will control which bills load into the screen. You must choose one vendor at a time to pay with a credit card. 
4. Click the checkboxes for the bills you want to pay or type in the amount under the Paid column on the right.
5. Payment Information
a. Choose Branch and Payment Date
b. Choose to pay with a bank account or credit card
i. Choosing bank account will send the payment to the Print Checks function where you can then print and send a check. Choosing credit card will credit off the original vendor bill and create a bill on the credit card’s vendor account. 
6. Go to the Vendor Credits tab and select the checkboxes to apply credits to a bill
[bookmark: _Toc469993188]Print Checks
1. Open the Print Checks function
2. Choose which bank account is paying the check
3. Select which checks will be printed or choose Select All
4. Margins:
a. Use the arrows to move the text to line up appropriately on the check
b. Push Test to preview the page and print
c. Apply to save the margins of the check
5. Click Print Bill List to preview and print a list of bills by vendor with credits, discounts and cash applied
6. Select Print to open a print preview of the checks to be printed
a. After closing the print preview, Sedona will ask if you wish to mark these checks as printed. Select Yes to remove these checks from the Print Checks function. You will then have the option to print remittances. 
[bookmark: _Toc469993189]Enter a Manual Check
1. Open the Write Checks function
2. Search for a customer or vendor (address will automatically populate)
3. Enter a check number, amount and memo. 
1. If there is no check number, enter a reference such as “auto draft” or “eft”
5. Check In Print Queue to print this check later from the Print Checks function
a. Select Print at the bottom of the screen to print this single check immediately
6. Select Recurring Payment to put this check into the Recurring Items function
7. Use the binoculars next to the Costing field to link this check to a job 
8. Select a GL Account, description, amount, branch, and category
9. Save
Note: If you check the Recurring Payment checkbox, after you save the check, another form will come up requiring recurring payment information. Enter the frequency and correct dates for the check.
[bookmark: _Toc469993190]Create A/P Recurring Items
Note: Checks and Bills must be designated as recurring items through Write Checks or Bills before they will appear in the Recurring Items function.
1. Click on the Recurring Items function
2. Choose the recurring item from either Checks or Bills
3. Double click or select Create to make the next scheduled entry
4. Click Save to print individually or send to the Print Checks function
Note: Items in red are past due.  Print items to turn them black.

SedonaOffice Add-Ons	
[bookmark: _Toc469993191]Managing BFIS Reports
[bookmark: _Toc469993192]Report Types
BFIS creates reports each time invoices are sent which give details about invoice delivery. An ASTUTE employee will copy these report to your server daily. 
1. There are four report types:
a. rmrcap_invdropd – details of undeliverable invoices 
b. rmrcap_nffwd –invoices for sites with a National Change of Address request
c. rmrcap_cd1rejs – code one reject addresses for which BFIS cannot produce a postnet barcode
d. rmrcap_trackng – list of all invoices received on the given date
Note: NFFWD and Cd1Rejs reports may show address discrepancies, but this does not necessarily mean that those invoices have been dropped. The Invdropd report is the only report that lists which invoices have been dropped. 
[bookmark: _Toc469993193]Viewing the Reports 
1. BFIS reports are located on the SedonaOffice server in your public documents folder:
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2. To access these reports from your remote desktop, navigate to Public Documents/BFIS Reports. The BFIS Report Meanings document located here gives details about how to read these reports. The folder named after your company will hold the BFIS reports. 
3. You can also access these folders by logging into your file depot, which is a quick way to view all files on your virtual machine from your web browser using the following URL:
a. http:// yourcompany.sedonaoffice.com:8080*
*replace “yourcompany.sedonaoffice.com:8080” with the appropriate URL provided in your Login Credentials email

4. You will be prompted to sign in using your windows username and password.
a. This will not include the domain name ’SedonaASP\’
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5. Once you are connected, you can upload files to your server, open files from these folders and copy files to your own desktop.
[bookmark: _Toc469993194]Reading the Reports 
[bookmark: _Toc469993195]Tracking Report
1. The tracking report will show basic information about the invoices sent in each round, including each invoice number, a Y or N indicating if the invoice was mailed or not, and a total number of mailed and dropped invoices. 
Example:
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[bookmark: _Toc469993196]Dropped Invoice Report
1. A dropped invoice means it is undeliverable by USPS, typically due to incorrect address. The exception to this is when an invoice has a $0 balance due, which BFIS automatically drops. The most important parts of the dropped report are the invoice number, the drop reason, and the total number of invoices dropped. 
Example: 
[image: ]
2. Use the drop reason to determine if there is a problem with the address entered into SedonaOffice or if the invoice was dropped for outside reasons. 
[bookmark: _Toc469993197]Code 1 Reject Report
1. If an address is in the reject report, it does not mean that the invoice did not send. These addresses do not exactly match with USPS, but are still deliverable. 
2. In the example below, you can see that the address has an unmatched house number. This invoice may have been deliverable because the mail carrier knows the area very well. However, a future mail carrier may not be able to deliver this invoice, so it is a good idea to attempt to match these addresses with USPS, but it is not absolutely necessary. 
Example: 
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[bookmark: _Toc469993198]NFFWD Report
1. This report shows invoices that have been sent to an address with a National Change of Address request filed with the USPS and are being forwarded. 
[bookmark: _Toc469993199]Changing the Bill To Information
1. Once you discover the reason the invoice was dropped, go to USPS.com and use the lookup tool on the left side of the screen to determine the correct address. 
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2. Then edit the address in the billing record on the account. 
3. Once you have corrected the billing addresses in Sedona, you can then open the appropriate invoice, change the bill to (upper left button), and then add the invoice to the print queue again.
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4. If the address appears to be correct, you may have formatting issues on the customer’s SedonaOffice page, so check that all address info is entered in the appropriate labels on the bill to.
Note: If you have completed all of these steps and still cannot determine why the address won’t deliver, you will need to contact the dealer or customer. If the customer confirms that the address is correct, we can request that BFIS puts a bypass on this address, so that it will be mailed despite the discrepancy. Then you can wait to see if it comes back to you as a return to sender in the mail.
[bookmark: _Toc469993200]Using EFT in SedonaOffice
[bookmark: _Toc469993201]Payment Methods
Credit cards and banks are stored within the Payment Options folder of the customer page . You can double click on the card/bank name to see more information about the payment method. The Auto column will have an N or Y indicating if this is an auto-process payment method.
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[bookmark: _Toc469993202]Add a Payment Method
1. Right click on ‘Payment Options’ in the customer file tree and select ‘Edit Electronic Funds Transfer.’
1. Use the dropdown under Banks/Cards on File to choose New Bank/CC. Banks are added in the left column and credit cards in the right column. 
[image: ]
1. Enter all of the information in this form relevant to the payment method:
2. Required Fields:
0. Card Type
0. Name
0. Card Number
0. Expiration Date
0. Bill Address and zip code
0. Payment Method
1. After clicking Apply, you’ll notice a pause as SedonaOffice verifies the payment information. Wait for the payment method to appear on the customer page behind this form. 
[bookmark: _Toc469993203]Using Auto Draft
The Auto Processing checkbox will determine if this card/bank is charged automatically when invoices are created. If you select the checkbox next to Recurring, a transaction will automatically be submitted each time a cycle invoice is created.  The Print Cycle Invoices checkbox can be deselected when this is chosen so that the customer will not receive a paper invoice from the print queue for auto-payment invoices. The Hold Day option under Auto Processing will determine on which day of the month the transaction should be created. Only one payment method can be designated as an auto processing card per account.
[bookmark: _Toc469993204]For Cycle Invoices
1. Check the Recurring checkbox to designate that a charge should automatically be created for each cycle invoice that is generated on this account. 
1. Enter a number in the Hold Day dropdown
5. The number you enter in the hold day reflects the day of the month you wish to charge the card. For example, entering a 5 here means that the charge will be entered on the 5th of each month/cycle.
5. If you enter a 1 in this dropdown, the card will be charged on the date that is chosen as the ACH Hold Date in the cycle invoicing process each month. Keep in mind that from now on, you will want to pay close attention to the ACH hold date field in Cycle Invoicing. This date will determine when all recurring auto-process cards will be charged if they have a hold day of 1.
1. You should enter a 2 rather than a 1 in the hold day dropdown for customers that want to be charged at the beginning of the month to prevent these customers from being charged automatically on the date chosen in Cycle Invoicing. 
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For example, your company may typically generate cycles on the 15th of each month for the next month’s cycle, and you charge all credit cards and banks that are set up for auto process on the first of the next month, meaning you enter a hold day of the 1st into Cycle Invoicing. However, one customer does not want their card to be charged until the 5th of each month. You would therefore choose 5 under the hold day dropdown of the EFT setup form and this customer’s transaction will be created on the 15th of each month, but not submitted/charged until the 5th. All other customers have a 1 in the hold day dropdown of their payment method, so SedonaOffice will look at the hold date in Cycle Invoicing - in this case the 1st - and the card/bank transactions will be submitted on that day.
[bookmark: _Toc469993205]For Job, Service and Miscellaneous Invoices
1. Check Non-Recurring to designate that a charge should automatically be created for every job, service or miscellaneous invoice that is created for this account.
6. When this is checked, a blank box will appear. This field is where you will enter the maximum daily charge on this card/bank for these types of invoices. For example, I have entered 500 to show that the customer does not wish to be charged more than $500 per day when a job, service or miscellaneous invoice is created on their account. 
[bookmark: _Toc469993206]Enter Transactions
Once all cards and banks are entered, you can begin to submit transactions. This can be done from four different areas within the customer page:
[bookmark: _Toc469993207]From the File Tree
1. Right click on Payment Methods and choose ‘Enter New EFT Transaction’:
[image: ]
[bookmark: _Toc469993208]From the Payment Method
1. Double click on the card or bank from within Payment Options. 
1. Click on New Transaction at the bottom left.
[image: ]
[bookmark: _Toc469993209]From an Invoice
1. Open an invoice and click on EFT at the bottom right:
[image: ]

[bookmark: _Toc469993210]From the Open Items Page
1. Right click on an invoice and select ‘Make EFT Payment’:
[image: ]
1. All of these methods will take you to the New EFT Entry form:
[image: ]
1. Select which bank or card you’re charging. 
1. Give the payment a description.
1. Enter a hold date (date the card will be charged), and enter a check number if necessary. 
1. Check each invoice that should be paid in this transaction, or select ‘Pay All Invoices.’ 
1. The total will add up in the amount column. If there are no invoices on the account or you do not wish to pay off one of the existing invoices, check unapplied cash or advance deposit. You also have the option to put the charge toward Miscellaneous Income by choosing a GL Account. If you need to remove a charge from an invoice, first void the charge from within payments gateway, then open this form and select Void. If you are not able to void, you may need to re-invoice. 
[bookmark: _Toc469993211]Review Transactions
Use the ACH Batch report in the Accounts Receivable section of Report Manager to determine which transactions have been declined. 
1. Click on EFT History in the customer’s file tree to view all EFT transactions.
[image: SNAGHTML954ff6]

0. Pending transactions will show ‘Not Submitted’ until they are uploaded by ASTUTE
0. Funded transactions will show a date and batch code
0. Unfunded transactions will have ‘Declined’ in place of a date
2. Use the ACH Batch report to determine the reason for decline by the response code. A List of EFT response codes can be found here:
Decline Codes
1. Once the transactions have been processed by ASTUTE, all of the funded transactions will automatically be entered into Payment Processing as batches:
[image: ]
1. You should confirm that these charges have hit your bank account, and then you can deposit the batches. 
[bookmark: _Toc469993212]Void or Reverse a Payment
[bookmark: _Toc469993213]Void in SedonaOffice
1. If an EFT transaction has not yet been uploaded, it can be voided from within SedonaOffice
1. Open the customer account and click on EFT History
1. Double click on the transaction to be voided. 
1. Select Void at the bottom right. 
[bookmark: _Toc469993214]Reverse in Payments Gateway
1. If the transaction has been settled or is in the process of settling within SedonaOffice, you must reverse the transaction. This should be done from Payments Gateway.
1. Go to www.paymentsgateway.net and login.
1. Select search on the left and enter your search criteria (dates/customer name):
[image: ]
1. Select the transaction that needs to be refunded from the list that populates:

[image: SNAGHTML1e07152]

1. The details for the transaction will load. If you wish to delete this payment, select void. It can be re-submitted from within SedonaOffice. If you need to refund the customer, select reverse at the bottom:

[image: ]

1. On the next page, enter the amount to refund the customer, and select reverse: 
[image: ]
[bookmark: _Decline_Codes][bookmark: _Decline_Codes_1]
[bookmark: _Toc469993215]Response Codes

	Code
	Name
	Description

	A01
	Funded
	Funded

	F01
	Mandatory Field Missing
	Mandatory Required Fiels is missing from the file

	R01
	Insufficient Funds
	Balance is not sufficient to cover value of transaction

	R02
	Account Closed
	Previously Open Account has been closed

	R03
	No Account
	Account is closed or doesn't match name submitted

	R04
	Invalid Account Number
	Account Number structure is invalid

	R05
	Prenote Not Received
	Prenotification was not received

	R06
	Returned per ODFI
	ODFI has requested RDFI to return this item

	R07
	Authorization revoked
	Account holder has revoked company's authorization

	R08
	Payment Stopped
	Account holder has stopped payment on this single transaction

	R09
	Uncollectable Funds
	Balance is sufficient but can't be released

	R10
	No Authorization
	Account holder advised that transaction is not authorized

	R11
	Check Safekeeping Return
	Return of a check safekeeping entry return

	R12
	Branch Sold
	Account now at a branch sold to another financial institution

	R13
	RDFI Not Qualified
	RDFI Not qualified to participate

	R14
	Deceased
	This account holder is deceased

	R15
	Beneficiary Deceased
	Beneficiary entitled to benefits is deceased

	R16
	Account Frozen
	Funds unavailable due to action by RDFI or other legal action

	R17
	Field Record Criteria
	Field Record/Edit Criteria

	R20
	Non Transaction Account
	Policies/Regulations restrict activity to this account

	R23
	Payment Refused
	Account holder refuses transaction because amount is inaccurate or other legal

	R24
	Duplicate Entry
	Transaction Appears to be a duplicate item

	R26
	Mandatory Error
	Transaction is missing data from a mandatory field

	R28
	Invalid TRN
	Transit Routing Number is Invalid

	R29
	Corporate Not Authorized
	Corporate Receiver has notified RDFI that Corp entry is not authorized

	R31
	ODFI Permits Late Return
	ODFI Agrees to accept a return

	R50
	Invalid Company Id
	The Owner CompanyId is NOT valid

	R56
	Invalid Transaction Date
	Date specified is Invalid

	R57
	Stale Date
	Transaction is too old for processing

	R95
	Over Limit
	This transaction is over your authorized limit

	R96
	Account on Hold
	This company account is on hold

	R97
	RDFI Does Not Participate
	RDFI does not allow this type of transaction

	R98
	Invalid Password
	The password supplied was invalid

	R99
	Declined Unpaid Items
	The account or ID has been declined due to unpaid items

	S01
	Funded
	Funded

	U01
	Merch Auth Revoked
	Merchant not allowed to access customer account

	U02
	Account Not Approved
	Customer Account is in the ACH DIRECT known BAD LIST

	U03
	Daily Trans Limit
	Merchant Daily Limit Exceeded

	U04
	Monthly Trans Limit
	Merchant Monthly Limit Exceeded

	U05
	AVS Failure Zipcode
	AVS state/zip code check failed

	U06
	AVS Failure AreaCode
	AVS state/area code check failed

	U07
	AVS Failure Email
	AVS Anonymous email check failed

	U08
	Daily Velocity
	Account has more transactions then the daily velocity limit

	U09
	Velocity Window
	Account has more transactions then the velocity window allows

	U10
	Duplicate Transaction
	Transaction has the same attributes as another transaction

	U11
	Recur Trans Not Found
	Recurring Transaction not found

	U12
	Bad Status for Update
	Original Transaction not Voidable

	U13
	Orig Trans Not Found
	Transaction to be voided not found

	U14
	Bad Type of Orig Trans
	Void/Capture and Original Transaction do not agree

	U18
	Update Failed
	Void or Capture failed

	U19
	Invalid TRN
	Account ABA Number is invalid

	U20
	Invalid Credit Card Numb
	Credit Card Number is Invalid

	U21
	Bad Start Date
	Bad Start Date

	U22
	Swipe Data Failure
	Swipe Data is malformed

	U23
	Invalid Expiration Date
	Malformed Expiration Date

	U51
	Merchant Status
	Merchant is not live

	U52
	Type Not Allowed
	Merchant not approved for transaction type

	U53
	Per Trans Limit
	Transaction amount exceeds merchants per transaction limit

	U54
	Invalid Merchant Config
	Merchants configuration requires updating - call customer support

	U80
	PreAuth Decline
	Transaction was declined due to preauthorization

	U83
	Auth Decline
	Transaction was declined due to authorizer declination

	U84
	PreAuth Timeout
	PreAuthorization not responding

	U85
	PreAuth Error
	PreAuthorization Error

	U86
	AVS Failure Auth
	Authorized AVS
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